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P R E F A C E  

Contents and Conventions 

P.1 Overview 
In this chapter we describe the scope of the manual, the conventions used and most importantly 
the safety guidelines. The SQUID VSM using cryogens and high power components, we strongly 
recommend to be aware of all hazards in order to prevent injuries and system damage. 

P.2 Scope of the Manual 
This manual discusses the MPMS SQUID VSM. It contains information about the basic 
functionality, describes the hardware that is unique to the system, and explains how to use the 
system and the SQUID VSM MultiVu software. 

P.3 Conventions in the Manual 
File menu Bold text identifies the names of menus, dialogs, options, buttons, and panels 

used in the SQUID VSM MultiVu software. 

File > Open The > symbol indicates that you select multiple, nested software options. 

.dat The Courier font indicates file and directory names and computer code. 

Important Text is set off in this manner to signal essential information that is directly 
related to the completion of a task. 

Note Text is set off in this manner to signal supplementary information about the 
current task; the information may primarily apply in special circumstances. 
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This symbol signals specific caution or conditions that could result in system 
damage, bodily harm, or loss of life. 

 

 

This symbols signals electrical hazards that could result in bodily harm, or loss 
of life. Used at all accessible 200-230 V power outlets. 

 

 

This symbol signals cryogenic hazards that could result in bodily harm and 
loss of life. Used wherever accessible parts could reach temperatures below 
0°C (32°F). 

 

 

This symbol signals hot surface hazards that could result in bodily harm and 
loss of life. Used wherever accessible parts could reach temperatures above 
60°C (140°F). 

 

 

This symbol signals information on fusing. 

P.4 Safety Guidelines and Regulatory Information 
Before using this product, please read the entire content of this User’s Manual and observe all 
instructions, warnings and cautions. These are provided to help you understand how to safely and 
properly use the SQUID VSM and reach its best performances. 

Quantum Design Inc. disclaims any liability for damage to the system or injury resulting from 
misuse or improper operation of the system. Please contact your Quantum Design representative 
for any service issues. 

This product is NOT operator-serviceable except for simple operations described in Appendix A. 

Observe the following safety guidelines when you use your system: 
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o In case of emergency, switch the power off at the rear of the cabinet or unplug the main 
power cord from the laboratory power outlet. 

o To prevent electrical shock, unplug the system before you install it, adjust it, or service it. 

o The instrument must be plugged into a 200-230VAC 50/60HZ single phase appliance 
outlet fused to 16A (Outlet type IEC 60309, 200-250V, 16A, 2P+E, 6H, blue). See 
Appendix D.2. 

o To prevent damage, always power down module bay tower when removing/installing 
modules. 

o For continued protection against fire hazard, electric shock and irreversible system 
damage, replace fuses only with same type and rating of fuses for selected line voltage. 
Information about user-accessible fuses and their replacement is summarized in 
Appendix A.3.9. 

o Direct contact with cryogenic liquids, materials recently removed from cryogenic liquids, 
or exposure to the boil-off gas can freeze skin or eyes almost instantly, causing serious 
injuries similar to frostbite or burns.  Wear protective gear, including clothing, insulated 
gloves, and eye protection, when you handle cryogenic liquids. 

o Transfer cryogenic liquids only in areas that have adequate ventilation and a supply of 
fresh air. Nitrogen and Helium gas can displace the oxygen in a confined space or room, 
resulting in asphyxiation, dizziness, unconsciousness, or death. 

o Do not obstruct the cryogen exhaust lines. The exhaust should be visible to the user when 
operating the system. 

o Keep this system away from radiators and heat sources. Provide adequate ventilation to 
allow for cooling around the cabinet and pump console. The distance between the system 
and wall should be at least 30 cm. (12 inches) in each direction. Do not obstruct the 
ventilation openings on the top of the cabinet. 

o Do not obstruct the ventilation outlet located on the left side of the pump console and air 
intake at the rear. The clearance around the pump console should be at least 20 cm. (8 
inches) in each direction. 

o Do not obstruct or pinch the pump exhaust line located at the rear of the pump console. 

o Refer to the manuals for the pump, monitor and printer for additional safety warnings and 
notices. 
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C H A P T E R  1  

Getting Started 

1.1 Overview 
In this chapter we give a brief system introduction and describe how to get started and to 
perform the most common tasks with your SQUID VSM. The instructions are meant to be brief 
in order to get a quick overview of the routine operations and to get familiarized with the system. 
More details are provided in the rest of the manual. 

1.2 Introduction 
The Quantum Design Magnetic Property Measurement System (MPMS) is a family of analytical 
instruments configured to study the magnetic properties of small experimental samples over a 
broad range of temperatures and magnetic fields.  Automated control and data collection are 
provided by a computer and various electronic controllers.  Extremely sensitive magnetic 
measurements are performed with superconducting pickup coils and a Superconducting Quantum 
Interference Device (SQUID).  For this reason, the MPMS family of instruments are called 
SQUID magnetometers. 

To optimize speed and sensitivity, the MPMS SQUID VSM utilizes some analytic techniques 
employed by Vibrating Sample Magnetometers (VSMs). Specifically, the sample is vibrated at a 
known frequency and phase-sensitive detection is employed for rapid data collection and 
spurious signal rejection.  Unlike traditional (non-superconducting) VSMs, the size of the signal 
produced by a sample is not dependent on the frequency of vibration, but only on the magnetic 
moment of the sample, the vibration amplitude, and the design of the SQUID detection circuit. 

The MPMS SQUID VSM utilizes a superconducting magnet (a solenoid of superconducting 
wire) to subject samples to magnetic fields up to 7 Tesla (70 kOe).  The SQUID and magnet must 
both be cooled with liquid helium.  Liquid helium is also used to cool the sample chamber, 
providing temperature control of samples from 400 down to 1.8 Kelvin.  To help conserve liquid 
helium, the system is designed to use less costly liquid nitrogen to intercept heat bound for the 
helium tank.  The SQUID VSM will only operate properly with both cryogens in use:  liquid 
helium and liquid nitrogen. 

For details on hardware and measurement methods we refer to chapter 3 and 4 respectively. 
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1.3 Common Tasks 
The most common tasks necessary to perform a measurement are summarized in the following 
flowchart: 

    

 

    

 

 

 

1.3.1 Mounting Samples 
• For the most accurate magnetic moment measurements, measure the magnetic signature 

of the sample holder before mounting the sample and subtract its signal from the total 
signal. 

• Mount samples very securely to a sample holder to achieve accurate magnetic moment 
readings.  The sample holder will undergo vibration at 14 Hz.  (GE) 7031 varnish is 
recommended, or a glue that will withstand the temperature extremes and sample holder 
thermal contraction during the experiment.  7031 varnish can be dissolved with alcohol 
or toluene to remove samples and re-use sample holders.  Do not soak the entire sample 
holder in solvents like acetone—they may affect the adapter at the end. 

• Mount samples on-axis with the sample rod to minimize dependence of the magnetic 
moment readings on the angular orientation (about a vertical axis) of the sample rod. 

• Quartz and brass sample holders are supplied.  The quartz holders are brittle and fragile, 
but have the smaller magnetic signature.  For samples having a large moment, the brass 
sample holders will have negligible magnetic background and may be easier to handle. 

• Use the supplied sample mounting station to place the sample at the proper location on 
the sample holder as shown below.  The location markings are on a mirror to help 
eliminate parallax.  Load the sample holder by retracting the spring-loaded end with 
your fingers and inserting the top end of the sample holder. 

 

 

 

 

 

 

 

 

Mounting 
Sample 

Loading 
Sample 

Centering 
Sample 

Measure 
Sample 

Fill liquid 
He 

Fill liquid 
N2 + 
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Figure 1-1. Sample mounting station. 

 
• Custom sample holders may also be used, but accuracy and reproducibility of magnetic 

moment readings may be compromised.  The supplied brass and quartz holders are 
manufactured to ensure optimal geometry, and the SQUID VSM software can accurately 
predict their thermal contraction in order to keep samples properly centered in the 
detection coils.  User-designed sample holders may not meet these aims.  For example, 
plastic drinking straws may be used, but are not recommended because: 

 

○ It is difficult to mount samples rigidly enough to the straw to withstand the 
acceleration of the VSM oscillation. 

○ It is difficult to secure straws to sample rods perfectly co-axially. 

○ Plastic straws do not withstand the upper end of the instrument temperature range 
and will melt. 

○ Above room temperature, the thermal expansion of plastic drinking straws is not 
predictable, and the auto-tracking algorithms used in the SQUID VSM to help track 
sample position do not apply. 

1.3.2 Loading and Unloading Samples 
1. Attach a new sample holder with mounted sample to a sample rod. Make sure that the mating 

surfaces of the adapters are clean and that they are screwed all the way in. When screwing 
your sample holder to the sample rod, hold the rod at the blue bearing. 

 

 

                                                 Figure 1-2. Sample holder mounting. 
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2. Select the software menu item “Sample > Install/Remove…” 

 
 

 

 

 

 

 
Figure 1-3. Sample installation menu. 

The Install/Remove Sample Wizard begins.  It guides you through the rest of the sample loading 
process, including warming the chamber to room temperature and venting the chamber, 
specifying a data file for saving measurement data, entering sample and sample holder 
information, and centering the sample.  If you only wish to unload a sample, the wizard instructs 
you how to do this. 

 

Figure 1-4. Sample installation wizard. 

3. Follow the instructions in the wizard. 

Alternatively, you may unload samples with the procedure below, or load samples without 
specifying data file, sample, or sample holder information.  This procedure will not help you 
center your sample, either. 

 
1. Stop any measurement in progress.  Make sure the chamber temperature is above 295 

K and below 315 K.  Set temperature and wait if necessary, to prevent condensing or 
freezing air and moisture in the chamber. 

2. Press “eject”   
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The chamber vents continuously with helium and the VSM head moves to the top position. 
3. Remove the cap from the VSM head. 

Figure 1-5. Sample rod installation. 

4. Remove the installed sample rod. Insert a new sample rod into the chamber if desired. 

5. Replace the cap and press “load”  

The chamber is purged with helium. You will need to specify a data file and center your new 
sample in order to perform measurements. 

          

 
Never press “load” without having replaced the cap. Air will be sucked into the system and 
cause ice accumulation in the sample space. 

1.4 Centering Samples 
• The sample must be centered within the detection coils for accurate magnetic 

measurements.  This can only be done if the sample is mounted near the correct location 
on the sample holder, as shown in the section “Mounting Samples” above. 

• Whenever you load a new sample, specify the sample offset so that it may be properly 
centered during measurements.  This is the distance from the bottom end of the sample 
holder to the (magnetic) center of the sample. 
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• The Install/Remove Sample Wizard helps you 

specify the sample offset.  If you are not using 
the wizard, select “Sample > Manual Locate.” 

• The sample offset is defined as the distance 
from the bottom end of the sample holder to the 
sample location and is usually about 66 cm.  
The motor armature position should be roughly 
centered in the window of the VSM head.               Figure 1-6. Manual locate menu. 

          

• There are two different ways to enter the sample offset: 
○ The most accurate technique is to scan the sample.  The software moves the 

sample through the detection coils and analyzes the coil response to locate 
the sample.  To perform a good centering scan you may need to induce a 
magnetic moment > 1x10-7 emu in your sample by applying a magnetic field, 
or by changing the temperature. 

○ If your sample has a very weak magnetic response and inducing a magnetic 
moment is undesirable or impossible, scanning the sample may not work.  If 
your sample does not have a dipole-like response, scanning the sample may 
not work.  In these cases you can measure the sample offset with a rule or 
caliper before loading the sample and enter the sample offset manually. 

 

 
Figure 1-7. Sample centering scan. 

1.4.1 Scan the Sample 
1. Click “Scan for Sample Offset.”  The instrument moves the sample through the detection 

coils.  It may scan the sample several times to achieve optimum signal. 
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2. The signal is plotted in red as a function of position, along with a dipole response fit in 
green.  A good scan has one central peak with 
symmetric peaks on either side.  The center 
peak is approximately 170% the magnitude of 
the outer peaks, and opposite in polarity.  This 
is due to the geometry of the detection coils. 

3. The instrument calculates the sample offset 
based on the fit to the data and asks you for 
confirmation to use the calculated value.  Click 
“OK” only if the fit and calculated sample 
offset look correct. 

                        Figure 1-8. Sample offset confirmation. 

1.4.2 Enter Sample Offset Manually 
1. Set the temperature to 305 K and wait for the chamber to reach 305 K.  The sample offset 

you measure at room temperature is not valid at other temperatures, due to thermal 
contraction of the sample rod.  If you are using the Install/Remove Sample Wizard, it will set 
the temperature for you. 

2. Click “Enter Offset Manually.” 

3. Enter the sample offset you 
measured.  This is usually about 
66 mm.  For accurate 
measurements, it is important to 
enter the offset as close as 
possible to the true value. 

4. Click “OK.” 

 
Figure 1-9. Manual sample offset. 

1.4.3 Automatic Centering 
• As the temperature of the sample changes, the dimensions of the sample rod and sample 

holder will also change, moving the sample away from the center of the detection coils.  
To compensate for this, use automatic centering to keep your sample centered during 
experiments. 

• There are two automatic centering modes: 

○ Auto-Tracking adjusts the sample location automatically to compensate for the 
thermal contraction of the sample rod and sample holder.  The brass or quartz 
sample holder must be specified in the “Sample Properties” dialog. 

○ Auto-Scan will periodically scan the sample at designated intervals to locate it.  
You may specify both time and temperature intervals.  No magnetic moment data 
will be collected while each scan is being performed. 
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○ You may also disable automatic centering.  This will reduce the moment accuracy 
and result in slight measurement errors if the chamber temperature changes. 

 
• Specify the automatic centering mode each time you start a measurement or each time 

you place a measurement command or a center sample command into a sequence.  The 
automatic centering setting is found on a “centering” tab for each measurement, or in a 
“centering” section on the “advanced” tab for some measurements. 

1.4.4 Measuring Samples 

1.4.4.1 IMMEDIATE MEASUREMENTS 

• Initiate sample measurement with the menu item 
“Measure > Measure…”  After you click the “Start” 
button, the measurement begins and the sample’s 
temperature, magnetic field, magnetic moment, and 
moment standard error data are recorded in the data file 
you have specified. 

 
 

           Figure 1-10. Measure menu. 

• Specify “Continuous Measuring” for a continuous stream of data, or “Single 
Measurement” to collect a single data point. 

                                          Figure 1-11. Measurement parameters. 
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• Specify the averaging time and the logging interval (for continuous measurement 
stream). 

• On the “Centering” tab, specify which automatic centering method is used to keep the 
sample centered. 

• On the “Advanced” tab, you may also set the vibration amplitude and SQUID range 
settings.  2 mm is the default vibration amplitude.  The instrument achieves highest 
sensitivity with vibration amplitudes greater than 2 mm.  (See chapter 4 for vibration 
amplitude considerations.) 

• Set the instrument temperature or magnetic field to 
vary those parameters as desired. 

1.4.4.2 SEQUENCE (AUTOMATED) 
MEASUREMENTS 

• To automate the temperature and magnetic field 
variation and the data collection, use a sequence.  
(See chapter 2 for more about sequences.) 

• The sequence commands “Measurement Commands 
> VSM > Moment vs. Field” and “Measurement 
Commands > VSM > Moment vs. Temp.” help 
automate very common magnetic measurements. 
      
      
   

 
Figure 1-12. Sequence 
commands menu. 

• For Moment vs. Field measurements, 
specify the shape and size of the magnetic 
field ramp by clicking and dragging in the 
“Select Start/End Quadrant” area to 
highlight the desired ramp shape, and by 
entering the Hmax, H0, and Hmin fields.   
Enter the field sweep rate and choose 
whether to stabilize at each measurement 
field or continue sweeping the field during 
measurements (sensitivity will be reduced.)  
Select the data spacing, averaging time, 
number of fields between Hmin and Hmax OR 
the field increment, and the number of 
measurements to repeat at each field. 

• The areas on the right side of the Moment 
vs. Field window indicate the approximate 
fields where measurements will be 
performed and the approximate time to 
perform the series of measurements, based 
on all of the settings. 

Figure 1-13. M(H) measurement setup.  
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• For Moment vs. Temperature 
measurements, specify the starting and 
ending temperature, temperature sweep rate, 
and whether to stabilize at each measurement 
temperature or continue sweeping the 
temperature during measurements.  Select the 
data spacing, averaging time, number of 
temperatures at which to measure OR the 
temperature increment, and the number of 
measurements to repeat at each temperature. 

 
• The areas on the right side of the Moment 

vs. Temperature window indicate the 
approximate temperatures where 
measurements will be performed and the 
approximate time to perform the series of 
measurements, based on all the settings. 

 

 

 
 Figure 1-14. M(T) measurement setup. 

1.5 Filling the Helium and Nitrogen Tanks 
 

 

 

W A R N I N G !  
Cryogens such as liquid helium and liquid nitrogen pose the following 
dangers:  (1) They can cause serious burns due to extreme cold.  (2)  They 
may expand explosively in closed containers if warmed above their boiling 
point.  (3) Their vapors may displace the breathable air in a closed room.  
(4) Liquid or vapors may backstream out of fill ports when removing 
caps/plugs/transferlines. 
 
To guard against these dangers, wear eye protection and protective clothing 
such as gloves and covered shoes when working with these cryogens.  Also 
ensure that the room has good ventilation.  Never disable relief valves, burst 
disks, or other safety devices on cryogen vessels and transfer equipment. 

Experienced personnel should perform or supervise these activities. 
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When transferring helium, the probe top plate is heated to avoid moisture and 
ice collection close to electronic equipment. Beware, surfaces of the top plate 
might reach high temperatures. 

 

The MPMS SQUID VSM usually requires nitrogen about as often as it requires helium.  It is 
however recommended to transfer the nitrogen and helium on separate days. Since there is no 
nitrogen level meter and the presence of nitrogen is critical for low temperature operation and 
minimizing consumption of helium, the nitrogen should be added once a week. Do not use a high 
pressure (~200 psi, ~14 bar) liquid nitrogen storage dewar, but instead stay with the lower 
pressure (22 psi, 1.5 bar) rated nitrogen containers. The helium should be added as needed. 

If you fill the tanks while the instrument is measuring, measurement accuracy and precision may 
be compromised. 

 Several indicators help you to track your helium level: 

a. Status bar: The MultiVu status bar shows the remaining helium volume in liters (see 
section 2.2.5). 

b. Color bar: The color bar in the status bar indicates the urgency for helium refill. 

 Green: Helium level sufficient for proper operation. 

 Yellow:  System is still operational but helium should be filled soon. 

 Red: Helium needs to be filled immediately. The system will shutdown and 
return to operational only once helium is filled up. 

c. Status light: The lower status light on the probe follows the same scheme as the color 
bar in the status bar (see section 1.6). 

1.5.1 Fill the Liquid Nitrogen Tank 
 

Open the fill port on the top of the nitrogen tank to determine if there is liquid nitrogen in the 
tank.  If there is liquid nitrogen in the tank there will be a slight overpressure and gas will be 
forced out when you open it.  If the tank has no liquid nitrogen there will be no overpressure or 
there will be a vacuum created by the liquid helium evaporation which chills the nitrogen tank 
below the nitrogen boiling point—air will be sucked in when you open the tank.  This vacuum 
effect can also be generated immediately after transferring liquid helium into the helium tank 
because the high flow of cold helium gas during the transfer may also cool the nitrogen tank 
below the nitrogen boiling point.  Therefore, this check is only reliable two hours or more after 
transferring liquid helium into the instrument.  (It is best to perform this check before starting to 
fill the helium tank.) 
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1. Connect the hose to the nitrogen storage dewar. 

 

 
Figure 1-15. Liquid/Nitrogen transfer tank. (only use low pressure containers p< 22psi, 1.5 bar) 

2. Open one nitrogen fill port and insert the hose. 

 

 
    Figure 1-16. Filling liquid nitrogen. 
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3. Open the valve on the nitrogen storage dewar to start the transfer. 

 

CAUTION: If during the start of the transfer the rear exhaust does not open within the first 
30 seconds, then stop transferring and refer to Appendix A.3.10. 

4. Transfer until the tank is full.  Liquid nitrogen droplets will be expelled from the exhaust 
hose connected to the back of the MPMS SQUID VSM when the tank is full. The rubber 
hose exhaust should be visible to the operator when operating the system, in particular 
during transfers. 

5. Close the valve on the nitrogen storage dewar. The nitrogen fill port and adapter will be 
frozen. Wait a few minutes until the hose and fill port warm up. Remove the hose and 
replace the plug in the nitrogen fill port. 

 

 
 CAUTION:  Cold nitrogen gas/liquid might backstream out of the open port. 

  
 

 

SERVICE NOTE: Inspect o-rings in the nitrogen inlet fittings once a month. Spare o-
rings can be found in your utility kit in case they are damaged. Apply vacuum grease to 
keep them lubricated. Maintaining the nitrogen ports is important because it will prevent 
from ice plugging which can cause irreversible damage to the system. 

1.5.2 Fill the Liquid Helium Tank 
 

 

Ramp the field to zero before starting transferring helium. Introducing warm gas into the 
dewar will cause the gas-cooled magnet to quench. 

 

1. Start the helium fill utility: 
 

Select the software menu item “Utilities > Helium Fill…”  

OR 

Press “fill” 

 

  
Figure 1-17. Utilities menu. 

The helium fill status and graph will be displayed. 
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Figure 1-18. Helium fill utility. 

2. Install attachments and insert the transfer line into the storage dewar: 
 

a. Make sure the appropriate extension for your storage dewar is on the long end of the 
helium transfer line—it should just reach the bottom of the storage dewar.  Make sure 
the tube fitting is also on the long end of the transfer line. 

b. Vent excess pressure from the helium storage dewar.  Then open the main valve on the 
helium storage dewar and insert the long end of the helium transfer line.                           

c. Tighten the fitting onto the tube adapter.  Then slowly lower the transfer line into the 
liquid helium until pressure builds up and gas begins flowing from the other end of the 
transfer line. 

d. Close the storage dewar safety relief valve so you may pressurize the storage dewar. 
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                 Figure 1-19. Liquid helium storage dewar.  

 
 

3. Open the helium fill port on the SQUID VSM and rapidly insert the transfer line (Fig. 1-20), 
then screw the fitting tight. 

 

 
 CAUTION:  Cold helium might backstream out of the open fill port. 

4. Monitor the transfer as follows: 
a. Lower the transfer line all the way to the bottom of the storage dewar then raise it up 

about 2 cm (1 in.) to prevent transfer of particulate contamination that has settled on the 
bottom. 

b. Pressurize the storage dewar with helium gas and maintain a gas flow into the dewar of 
about 3 liters per minute. The fill rate should not exceed 2%/minute. 

c. Monitor the helium level in the software, and adjust the gas flow to the storage dewar if 
the transfer rate slows. 

5. When the meter reads full (100% ~70 liters), stop pressurizing the storage dewar, open the 
safety relief valve on the storage dewar, and remove the transfer line from the SQUID VSM 
and quickly replace the cap on the fill port. Make sure cap is screwed on tight to avoid ice 
collecting and plugging of the transfer insert on the probe. Then remove the transfer line 
from the storage dewar and close the storage dewar main valve. Open the storage dewar 
pressure safety relief valve to ensure that no overpressure is building up inside the storage 
dewar.

Figure 1-20. Helium transfer line 
insertion. 
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1.6 Quick Reference:  Buttons and Status Lights 
The tables below describe the function and behavior of the three buttons and three status lights 
on the front of the SQUID VSM.  The status lights are embedded within the buttons, but they 
function independently of the buttons. 

 

Table 1.1 - Button Functions 

Button Name Used to… Function when Pressed 

 
Eject eject samples and 

open chamber 
Vents sample chamber continuously with helium and 
moves sample transport to top of travel.  Disabled 
when chamber is not at room temperature and when 
measurement is in process. 

 

 

Load close chamber Purges sample chamber with helium, leaves 
chamber evacuated 

 

 

Fill start helium level 
monitor 

Turns on helium level meter and starts the helium fill 
utility software.  Same as selecting “Utilities > 
Helium Fill…” 
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Table 1.2 - Status Light States 

Light State Color Means 

 on (solid) green Ready:  chamber has been purged, no sequence is running 

green Busy:  running sequence  blinking 
slowly 

yellow Busy:  purging chamber 

yellow Venting:  you should replace the cap and press the load button 
to purge the chamber as soon as possible 

 blinking 
rapidly 

red Error:  see the MultiVu event log (“Utilities > Event Log…”) 

green Status:  last Helium level reading OK  on (solid) 

yellow Status:  last Helium level reading < 25% (~18 liters).  OK to use 
system, but fill soon. 

 

blinking 
rapidly 

red Warning:  last Helium level reading extremely low (< 10% ~7 
liters).  Fill the system as soon as possible.  SQUID is not 
immersed in liquid helium (yields noisy measurements), inlet of 
flow controller is not immersed in liquid helium (yields loss of 
temperature control), magnet at risk (quench). System will shut 
down and recover once helium has been filled. Always fill both 
helium and nitrogen tanks 

 

 

blinking 
slowly 

yellow Busy:  reading helium level meter 
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C H A P T E R  2  

Software 

2.1 Overview 
In this chapter we describe MultiVu, the Windows™ software that 
coordinates the operation of the MPMS SQUID VSM hardware.  
MultiVu combines in a single user interface the basic instrument 
control, status reporting (section 2.2.5), data collection, graphing 
(section 2.4), sequence editing and sequence execution (section 2.3).  In 
addition to these features, MultiVu also contains instrument utilities, 
diagnostics, and error reporting. 

Start SQUID VSM MultiVu by double clicking the desktop icon: 

                         

 

MultiVu may be freely installed on additional computers.  Once installed, use the desktop icon 
for running MultiVu in simulation mode,  which works without SQUID VSM hardware attached.  
In simulation mode, MultiVu will not control the instrument, report the instrument status, collect 
data, or execute sequences.  Simulation mode allows you to use the sequence editing and data 
graphing features of the software from different computers, and is not intended for use on the 
SQUID VSM computer. 

When the MultiVu software is not running, the SQUID VSM goes into a hibernation state to 
prevent equipment damage.  Most users will leave MultiVu running on the SQUID VSM 
computer at all times.  MultiVu has a control to place the SQUID VSM in shutdown mode to 
conserve resources and still monitor the equipment status when it is not in use.  Generally, it is 
not necessary to quit the MultiVu software. 

2.1.1 Graphical User Interface 
The main MultiVu window displays essential status information about the instrument and allows 
controlling the instrument with simple mouse click commands.  The software also allows you to 
view two different types of files:  sequence files (.seq) and data files (.dat.)  Sequence files are 
used to automate the instrument operation.  Data files are collections of time-stamped data 
recorded by the instrument.  The commands available in the user interface change based on the 
type of file in the active window within MultiVu.  Shortcuts to common commands are found in 
context-sensitive menus you access by right-clicking on a data file (graph) window or on a 
sequence file window. 
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2.1.2 Automation With Sequences 
Instrument operation is automated with files called sequences.  Sequences are similar to simple 
computer programs or scripts that execute linearly.  Program branching and logic are not part of 
the MPMS SQUID VSM sequence language, but some looping operations are provided. 

MultiVu contains an easy sequence editor where you double-click the command you want to 
insert into a sequence file, then fill in command parameters in a pop-up window.  The editor 
allows typical Windows cut, copy, paste, and delete functions.  The predefined sequence 
commands allow tremendous flexibility when automating the SQUID VSM operation. 

For advanced users, the editor also allows access to the underlying script that is executed when a 
sequence is run, so that advanced programming techniques can be applied.  Such advanced 
techniques are not necessary for most users.  

MultiVu is also used to run, pause, lock, and abort sequences on the SQUID VSM and to view 
the status of sequences as they run. 

2.1.3 Data Files and Graphing 
Automation and the rapid data collection capabilities of the SQUID VSM allow large amounts of 
data to be saved to data files on the computer hard drive.  Data files may be viewed in different 
formats, including graphs, tables, data records, and even raw text.  The graph views may be 
extensively manipulated to help analyze data.  Graph views may also be saved as templates for 
viewing other data so that common graph settings, such as data item selection, axis scaling, 
display range, and grid display may be applied in aggregate to any data file.  The cells in table 
views may be copied and pasted into spreadsheets and graphing programs.  However, the data 
file itself may not be altered or edited in MultiVu, except by adding data records and comments.
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2.2 Graphical User Interface 

 
                                        Figure 2-1. User Interface overview. 

The main MultiVu window is shown above.  The tool bar, control center, sequence command 
bar, and status bar may each be docked and un-docked by double-clicking any non-control region 
or by dragging them around the main window.  They may also each be hidden using the “View” 
menu. 
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2.2.1 Menu Bar 
The Menu Bar contains menus for accessing all fundamental software features. 

 
Figure 2-2. Main menu bar. 

 FILE - File menu contains commands for opening, closing, and printing sequence files 
and data files; for saving sequence files, graph files and graph template files; for 
generating new sequence files; and for exporting data files to alternate formats. 

 EDIT - Edit menu contains commands to edit sequence files.  It is not shown unless a 
sequence window is selected. 

 VIEW - View menu allows you to show and hide the various components of the 
MultiVu graphical user interface, and to open different types of data file windows 
(graph view, table view, record view, raw data view.) 

 SAMPLE - Sample menu helps you install, remove, and locate samples and enter 
sample properties that are recorded in the data file. 

 SEQUENCE - Sequence menu contains commands to control the execution of 
sequences and to access the underlying script for advanced sequence editing. 

 MEASURE - Measure menu contains commands to control magnetic moment 
measurement, to change the data file where measurement data is recorded, to add 
comments to the data file, and to change the unit system used to record magnetic 
measurements. 

 GRAPH - Graph menu helps you manipulate the appearance of data file graph 
windows. 

 INSTRUMENT - Instrument menu contains commands to control the temperature, 
magnetic field, and vacuum state of the sample chamber, and to put the instrument into 
shutdown mode when unused.  For more information about the modes of instrument 
operation, see Chapter 3:  Hardware. 

 UTILITIES - Utilities menu contains commands to activate and configure instrument 
options, and to help maintain and troubleshoot the instrument, including filling the 
helium tank, tuning the SQUID, logging diagnostic data, and viewing error messages.  
(See appendix B for more information.) 

 WINDOW - Window menu helps arrange the open windows in MultiVu. 

 HELP - Help menu contains version and serial number information about the MPMS 
SQUID VSM, and access to the user documentation. 

 

 

 

 

 

 

 

 



Chapter 2 Section 2.2 
Software Graphical User Interface 

Quantum Design MPMS SQUID VSM User’s Manual, 1500-100, Rev. C0 2-5 
 January 2009 

 

2.2.2 Tool Bar 
The Tool Bar contains shortcuts for common menu items. 

 
                                                          Figure 2-3. Tool bar. 

2.2.3 Control Center  
The Control Center  (Fig. 2-4) provides an 
overview of the currently installed sample 
name, selected data file name, selected 
sequence file name, measurement status, 
and sequence execution status.  In addition, 
there are buttons to provide quick access to 
change the sample; change the data file; 
change the selected sequence; edit, run, 
pause, abort, or lock the selected sequence; 
and view a graph of the current data file. 

2.2.4 Sequence Command Bar 
The Sequence Command Bar (Fig. 2-5) is 
shown when you edit sequences.  You can 
toggle its display by selecting the “View > 
Sequence Command Bar” entry while 
editing a sequence. It contains commands 
you may insert into the sequence.  
Commands are organized in a tree 
structure.  Click “+” and “-” to expand or 
collapse tree branches.  Double click 
commands to insert them into the 
sequence.  More on sequences is found in 
the section below. 

 
Figure 2-4. Control 

center. 

 

 

 



Section 2.2 Chapter 2 
Graphical User Interface Software 

2-6 MPMS SQUID VSM User’s Manual, 1500-100, Rev. C0 Quantum Design 
 January 2009 

            Figure 2-5.       
Sequence command bar. 

 

2.2.5 Status Bar 
The Status Bar contains information about the status of the instrument.  The color of the helium 
tank level reading changes to yellow, then red when the helium level drops too low.  The length 
of the colored bar indicates the fill level. Click on the panels in the status bar as shortcuts to basic 
instrument control (such as temperature, magnetic field, and chamber vacuum state) and SQUID 
diagnostics. 

 

 
Sequence: 

-status 
-file name 
-execution line 

Temperature: 
-present state 
-setpoint 
-rate and mode 

Magnetic Field: 
-present state 
-setpoint 
-rate and mode 

Sample Chamber: 
-pressure 
-state 

Helium Tank: 
-approximate volume 
remaining 

SQUID: 
-reading 
-range 

Figure 2-6. Status bar. 

2.2.6 Sequence Window 
The Sequence Window is used for editing sequences.  More than one sequence window may be 
open at a time.  The selected sequence is always the sequence in the last sequence window that 
was active (clicked).  The control center reports the selected sequence file name.  The selected 
sequence is the sequence into which commands will be inserted when selected with the sequence 
command bar.  The selected sequence is also the sequence that executes when “Run Sequence” 

 is selected, when the control center “Run” button is selected, or when the menu command 
“Sequence > Run” is selected. 

2.2.7 Data Window (Table View) 
The Data Window (Table View) shows a data file in table format.  Each row in the table 
represents a single data record.  A data record consists of several data items collected 
simultaneously, such as sample temperature, magnetic field, and magnetic moment.  You may 
view a single data record in its own window by double-clicking any record in the table view. 

Cells and groups of cells in the table view can be selected, copied, and pasted into other 
spreadsheets and graphing programs for additional analysis using the standard Microsoft 
WindowsTM copy and paste features.
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2.2.8 Data Window (Graph View) 
The Data Window (Graph View) shows a data file in graph format.  Each point on the graph 
represents a single data record.  A data record consists of several data items collected 
simultaneously, such as sample temperature, magnetic field, and magnetic moment.  You may 
view a single data record in its own window by double-clicking any record in the graph view.  
The record view and graph view are linked, so that the highlighted point on the graph view 
corresponds to the record shown in the record view. 

The appearance of the graph view may be manipulated extensively and templates may be applied 
to the graph view so that you do not need to set each graph characteristic individually.  To learn 
more about manipulating the graph view, read the section below “Graphing Data Files.” 

2.3 Sequences 
 

Operation of the SQUID VSM can be automated using sequence files.  Sequence files are like 
simple computer programs instructing the instrument to carry out a number of operations in a 
predetermined order.  Operations typically found in a sequence file include changing the 
sample’s temperature, changing the magnetic field, and measuring the sample’s magnetic 
moment.  Additionally, commands may be placed in sequences to log diagnostic data, center the 
sample, record a comment in the data file, begin recording data to a new data file, generate a 
message on the computer screen, and even run another sequence. 

2.3.1 Editing Sequences 

• Create a new sequence file by clicking “New Sequence”  or selecting the menu item 
“File > New Sequence.” 

• Open an existing sequence file for editing by clicking “Open Sequence”  or 
selecting the menu item “File > Open… > Sequence.”  You will be prompted to locate 
the file you want to open. 

• The top of the sequence window shows the sequence file name.  An asterisk symbol (*) 
after the file name means the sequence has changed since last time the file was saved.  
Sequences must be saved before you run them. 

• Save a sequence file by clicking “Save Sequence”  or selecting the menu item “File 
> Save.”  If not already assigned, you will be prompted for a location and file name. 
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• Add a command to the selected sequence by double-clicking the command in the 
sequence command bar.  The new command is inserted above the highlighted command 
in the selected sequence window.  You will first be presented with a pop-up window to 
fill in command-specific information.  Then a summary of the command will appear in 
the sequence window.  More detail about each available sequence command is found at 
the end of this section. 

• Remove and reorganize sequence commands by highlighting 
them in the sequence window and using the “Cut,” “Copy,” 
“Paste,” “Delete,” and “Undo” commands in the “Edit” menu. 

• Disable commands in a sequence file without deleting them 
using “Edit > Disable.”  Enable a disabled command with “Edit 
> Enable” (Fig. 2-7).  A disabled command will be skipped 
during sequence execution.  Disabled commands are preceded 
by an exclamation mark symbol (“!”) in the sequence window 
and are changed from black text to gray text.  With this feature 
you may decide to execute or not execute some commands just 
prior to run time based on the immediate circumstances.  For 
example, you may wish to disable a series of commands that 
fall outside the meaningful measurement range for certain 
samples. 

Figure 2-7. Disabling 
sequence commands. 

• All of the commands found in the “Edit” menu are duplicated in a pop-up menu when 
you right-click any sequence window. 

2.3.2 Advanced Script Editing (Macros) 
Before running sequences, MultiVu automatically compiles sequence files into a Visual Basic for 
Applications type of script.  Users with programming experience may compile this script without 
running the sequence, and may then edit the script directly and run the edited script (macro).  
However, Quantum Design cannot certify the instrument behavior when it is automated with 
user-designed scripts.  Many checks and safeguards are bypassed when running a sequence script 
directly.  Novice users should not use this feature.  Advanced users with programming 
experience should use this feature with caution. 

 
• Compile and edit the sequence script using the menu commands “Sequence > Advanced 

> Compile Macro” and “Sequence > Advanced > Edit Macro.”  A Sax Basic editor 
window will appear. 

• Run the script with the menu command “Sequence > Advanced > Run Macro.”  You 
will be prompted to locate the script file to run.  Or you may run the script by clicking 

the “Start/Resume” button  in the Sax Basic editor window. 
• Find more information about the Sax Basic editor and scripting language by right-

clicking in the Sax Basic editor window and selecting “Help > Editor Help” and “Help > 
Language Help”. 
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2.3.3 Running Sequences 
 

• If the sequence file you want to run is not open, you need to open it.  Open an existing 

sequence file by clicking “Open Sequence”  or selecting the menu item “File > 
Open… > Sequence.”  You will be prompted to locate the file you want to open. 

• To execute a sequence, it must be the selected sequence.  If more than one sequence 
window is open, make sure the selected sequence is the sequence you want to execute. 

• Execute the selected sequence by: 

○ Selecting “Run Sequence”   

OR 

○ Selecting the menu command “Sequence > Run.” 

OR 

○ Selecting the “Run” button on the control center. 
• The status bar and the control center both display the status of the sequence execution.  

The sequence window also highlights the line currently being executed in green. 
• The toolbar, “Sequence” menu, and command center all provide the ability to pause 

( ) and abort ( ) sequence execution also.  When paused, the sequence window 
highlights the active line of the sequence in yellow. 

 

2.3.4 Locking Sequence Execution 
• When the sequence execution is locked, a sequence cannot be run, paused, or aborted 

without first unlocking sequence execution.  You cannot exit MultiVu when sequence 
execution is locked either. 

• No key or password is required to lock or unlock sequence execution.  The feature is 
intended only to prevent careless and accidental interference with instrument operation.  
It is not a security device against malicious behavior. 

• The instrument does not need to be running a sequence to lock sequence execution. 

• Lock sequence execution by clicking “Lock Sequence” .  Or select the menu item 
“Sequence > Lock,” or click the “Lock” button on the control center.  Type in your 
name and additional information so other users know why the sequence is locked, then 
click the “Lock” button.  All run, pause, and abort controls in the graphical user 
interface are disabled. 
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Figure 2-8. Locking/unlocking sequences. 

• Unlock the sequence by clicking “Lock Sequence”  again.  Or select the menu item 
“Sequence > Unlock,” or the “Unlock” button on the control center.  Then click the 
“Unlock” button on the popup dialog, which displays the name and message of the 
person who locked sequence execution. 

2.3.5 Sequence Commands 
The following sequence commands can be used in sequences. Option software purchased with 
the MPMS SQUID VSM may provide additional sequence command not listed here. 

2.3.5.1 SYSTEM COMMANDS: 

• Beep – Causes the computer to make the 
Windows default beep sound. 

• Call Sequence or Script – Suspends execution 
of selected parent sequence file and begins 
execution of specified child sequence file or 
script file.  When execution of specified child 
sequence file or script is complete, execution of 
selected parent sequence will continue with the 
next line. 

• Chamber Operations – Changes  state of the 
sample chamber atmosphere. (Fig. 2-9) 

• Remark – Serves as a message, comment, or 
visual break for the user only.  Does nothing 
when executed in a sequence file. 

• Scan Field – Creates a program loop for 
executing repeated commands at user-defined 
magnetic field increments. All commands 
between the “Scan Field…” line in the sequence 
and the “End Scan” line in the sequence will be  

Figure 2-9. Chamber operations      
menu. 
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be repeated at each magnetic field specified by the scan field command.  Set the initial 
and final fields and the scale on which the field increments should appear uniform 
(linear, H^2, H^1/2, 1/H, log(H).)  Also set the total number of field steps.  (For uniform 
linear spacing, you may alternatively set the field increment.)  Finally, specify the rate 
and approach mode used by the magnet controller to achieve each set point: 
○ Linear:  Controller will drive directly to each field and attempt to maintain the 

specified charging rate as closely as possible until each set point is reached.  At 
each set point the field will stabilize until the commands within the loop are 
completed. A small amount of field overshoot can occur in this mode. 

○ No Overshoot:  Controller will drive 80% of the way to each set point at the desired 
rate, and will then slowly step up (or down) to the set point to avoid any field 
overshoot.  At each set point the field will stabilize until the commands within the 
loop are completed.  This is intended for use with highly field-hysteretic samples. 

○ Oscillate:  Controller will intentionally overshoot each set point by 70% of the total 
field change, at the desired rate, and will then oscillate into the set point field in 
smaller and smaller overshooting steps.  At each set point the field will stabilize 
until the commands within the loop are completed.  This is intended to eliminate 
flux motion in the superconducting magnet windings, yielding a very stable 
magnetic field and more stable SQUID operation.  True zero field is best achieved 
using oscillate mode. 

○ Sweep:  Controller will drive directly from the initial field to the final field without 
stopping.  Each time a field increment defined by the command is reached, the 
commands inside the scan field loop will be executed, but the field will continue to 
change while they execute. 

• Scan Temperature – Creates a program loop for executing repeated commands at user-
defined temperature increments.  All commands between the “Scan Temperature…” line 
in the sequence and the “End Scan” line in the sequence will be repeated at each 
temperature specified by the scan temperature command.  Set the initial and final 
temperatures and the scale on which the spacing of the temperature steps should appear 
uniform (linear, 1/T, log(T).)  Also set the total number of temperature steps.  (For 
uniform linear spacing, you may alternatively set the temperature increment.)  Finally, 
specify the rate and approach mode used by the temperature controller to achieve each 
set point: 
○ Fast:  Controller will drive directly to each temperature and attempt to maintain the 

specified sweep rate as closely as possible until each set point is reached.  At each 
set point the temperature will stabilize until the commands within the loop are 
completed.  A small temperature overshoot can occur in this mode. 

○ No Overshoot:  Controller will drive to each set point at the desired rate until it is 
less than 30 seconds from achieving the setpoint, and will then slow the rate 
significantly to avoid temperature overshoot.  At each set point the temperature will 
stabilize until the commands within the loop are completed.  This is intended for 
use with highly temperature-hysteretic samples. 

○ Sweep:  Controller will drive directly from the initial temperature to the final 
temperature without stopping.  Each time a temperature increment defined by the 
command is reached, the commands inside the scan temperature loop will be 
executed, but the temperature will continue to change while they execute. 
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• Scan Time – Creates a program loop for executing repeated commands at user-defined 
time increments (or immediate repetitions with no time increment.)  All commands 
between the “Scan Time…” line in the sequence and the “End Scan” line in the 
sequence will be repeated at each time specified by the scan time command.  Set the 
total time in seconds and specify whether the spacing of events should be uniform in 
time or logarithmic in time.  And specify the number of steps.  This is the number of 
times the loop will be repeated.  (For uniform spacing in time, you may alternatively 
specify the time increment.)  If the total time is set to zero seconds, then the number of 
steps defines how many times the loop will be repeated in rapid succession. 

• Sequence Message – Displays a message on the computer screen and pauses sequence 
execution until the message is acknowledged or until a timer expires.  If the computer is 
set up with internet access and access to a mail server, a message can also be emailed 
with attachments such as data files. 

• Set Field – Sets the instrument’s magnetic field.  Specify the field, the charging rate, 
and the approach: 
○ Linear:  Controller will drive directly to the field and attempt to maintain the 

specified charging rate as closely as possible.  A small amount of field overshoot 
can occur in this mode. 

○ No Overshoot:  Controller will drive 80% of the way to the set point at the desired 
rate, and will then slowly step up (or down) to the set point to avoid any field 
overshoot.  This is intended for use with highly field-hysteretic samples. 

○ Oscillate:  Controller will intentionally overshoot the set point by 70% of the field 
change, at the desired rate, and will then oscillate into the set point field in smaller 
and smaller overshooting steps.  This is intended to eliminate flux motion in the 
superconducting magnet windings, yielding a very stable magnetic field and more 
stable SQUID operation.  True zero field is best achieved using oscillate mode. 

Notice that sequence execution continues with the next command in the sequence as 
soon as the field is set, not when the field set point is achieved.  To wait for a stable 
magnetic field before executing the next command, use the Wait command. 

• Set Temperature – Sets the sample temperature.  Specify the temperature, the rate, and 
the mode: 
○ Fast Settle:  Controller will drive directly to the temperature and attempt to maintain 

the specified rate as closely as possible until the set point is reached.  A small 
amount of temperature overshoot can occur in this mode. 

○ No Overshoot:  Controller will drive to each set point at the desired rate until it is 
less than 30 seconds from achieving the setpoint, and will then slow the rate 
significantly to avoid temperature overshoot.  This is intended for use with highly 
temperature-hysteretic samples. 

Notice that sequence execution continues with the next command in the sequence as 
soon as the temperature is set, not when the temperature set point is achieved.  To wait 
for a stable temperature before executing the next command, use the Wait command. 

• Shutdown – Places the instrument in shutdown mode to conserve resources.  The motor 
is powered down, the field is set to zero and the magnet controller is turned off, the 
heaters are turned off, and the valve driving the cooling power is closed. 

• Wait – Waits for specified conditions to be achieved, then delays a specified amount of 
time before continuing with sequence execution.  Conditions that can be specified to 
wait for are temperature stability, field stability, stepper motor position (not currently in 
use,) and chamber state.  This command is usually used immediately after another 
command in order to make sure the desired outcome of the first command is achieved 
before proceeding.  For example: 
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Set Temperature 77K at 10 K/min.  Fast Settle 

Wait For Temperature.  Delay 10 secs, No Action 

Measure Moment vs. Field… 

This sequence will wait 10 seconds after the instrument has achieved temperature 
stability at 77K before beginning a series of moment measurements at various magnetic 
fields.  Specify, also, what the instrument should do if an error occurs while waiting for 
the specified conditions (no action, abort sequence, or shutdown instrument.) 

2.3.5.2 ADVANCED COMMANDS: 

• Helium Low Pause – Pauses sequence execution if the liquid helium level drops below 
a specified reading on any normal helium level update.  This command is useful in very 
long sequences, when execution might take place over a period when nobody is present 
to monitor the helium level. For safety reasons, any running sequence will be 
automatically stopped and the system shutdown when the helium level gets below 10% 
(~7 liters). (see section 1.6) 

• Magnet Reset – Drives the magnet to zero field and applies heat to the superconducting 
magnet windings to remove trapped magnetic flux.  (See chapter 4 for application 
considerations.) 

• SQUID – Allows direct control of the instrument’s SQUID.  It is not usually necessary 
to utilize these controls because the instrument automation already optimizes SQUID 
operation. 
○ Quench – Applies heat to the SQUID or to the SQUID input (superconducting 

detection coil circuit) to eliminate standing currents. 
○ Reset – Holds the SQUID in reset for a specified amount of time, applying heat 

directly to the SQUID to return the SQUID output to nearly zero volts. 
○ Set Range – Sets the SQUID head gain manually.  Overrides any auto-ranging that 

may be in effect. 

2.3.5.3 MEASUREMENT COMMANDS 

• Log Data – Records specified diagnostic data to a data file at a specified rate.  No size 
limit is imposed on the data file generated, so the data file can get extremely large and 
difficult (or slow) to process.  See appendix B for more information on logging 
diagnostic data. 

• Sigma Log Data – Records specified diagnostic data to a data file at a specified rate.  
This command is similar to the Log Data command, except that it allows you to record 
statistics such as a running average and standard deviation for each data item, in each 
data record.  It may generate large data files with large header sections.  See appendix B 
for more information on logging diagnostic data. 

• VSM 
○ Adv. Measure – Creates a sequence step specifying all necessary parameters (see 

tabs below) to run a measurement.  
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                        Figure 2-10.  SVSM measurement parameters interface. 

 Specify “Continuous Measuring” for a continuous stream of data, or “Single 
Measurement” to collect a single data point. 

 Specify the averaging time and the logging interval (for continuous 
measurement stream). 

 On the “Centering” tab, specify which automatic centering method is used to 
keep the sample centered. 

 On the “Advanced” tab, you may also set the vibration amplitude and SQUID 
range settings.  2 mm is the default vibration amplitude.  The instrument 
achieves highest sensitivity with vibration amplitudes greater than 2 mm.  (See 
chapter 4 for vibration amplitude considerations.) 

 Set the instrument temperature or magnetic field to vary those parameters as 
desired. 

○ Center Sample – Allows you to reposition the sample for accurate measurements, 
and to change the automatic centering setting.  (Also allows advanced operations:  
moving the sample to any specified location, motor touchdown and motor home.)  
If your sample begins the sequence well-centered and automatic centering is 
enabled, this command may not be necessary. 

○ Datafile Comment – Puts a comment in the present data file, along with a time 
stamp.  The comment and time stamp constitute a single data record in the data file. 

○ Moment vs. Field – Performs a series of magnetic moment measurements at 
specified magnetic fields (see also chapter 1.)  You specify the maximum and 
minimum fields and one intermediate field (typically zero field) and the shape of 
the field ramps to perform, for example, four-quadrant or five-quadrant hysteresis 
loops.  The series may begin and end on either the maximum, minimum, or 
intermediate field.  You also control the rate of field change and whether the field 
stabilizes for each measurement or continues changing (sweeps) while the 
measurement is performed.  You specify the VSM measurement averaging time and 
the data spacing in field (H) (uniform in H, H^2, H^1/2, 1/H, or log(H)) and the 
number of data points per two-quadrant ramp.  Alternatively, you may also specify 
“continuous measuring,” in which case the instrument will record data as quickly as 
possible, with your averaging time, while the field sweeps are performed.  You may 
also repeat multiple measurements at each magnetic field.  The pop-up window 
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displays the approximate magnetic fields where measurements will be performed 
with your settings, and the estimated total time to perform the measurement series.  
An “advanced” tab also allows you to change the automatic centering setting, 
SQUID ranging, and diagnostic data logging, as well as a wait time at each field 
prior to commencing measurement, and the magnet approach mode (linear, 
oscillate, no overshoot—see set field command below) for each field.  The 
“advanced” tab also allows you to change the measurement amplitude and 
frequency.  (See chapter 4 for application considerations.) 

○ Moment vs. Temp. – Performs a series of magnetic moment measurements at 
specified temperatures (see also chapter 1.)  You specify the start and end 
temperature, and the rate of temperature change.  You also control whether the 
temperature stabilizes for each measurement or continues changing (sweeps) while 
the measurement is performed.  You specify the VSM measurement averaging time 
and the data spacing in temperature (T) (uniform in T, T^2, T^1/2, 1/T, log(T)) and 
the total number of data points.  Alternatively, you may also specify “continuous 
measuring,” in which case the instrument will record data as quickly as possible, 
with your averaging time, while the temperature sweep is performed.  You may also 
repeat multiple measurements at each temperature.  The pop-up window displays 
the approximate temperatures where measurements will be performed with your 
settings, and the estimated total time to perform the measurement series.  An 
“advanced” tab also allows you to change the automatic centering setting, SQUID 
ranging, and diagnostic data logging, as well as a wait time at each temperature 
prior to commencing measurement, and the temperature approach mode (fast settle, 
no overshoot—see set temperature command above) for each temperature.  The 
“advanced” tab also allows you to change the measurement amplitude and 
frequency.  (See chapter 4 for application considerations.) 

○ New Datafile – Changes the data file being used to record data (Fig. 2-10).  You 
must specify a path and file name for the new data file.  In addition, specify whether 
data should be written to a new version of the data file or appended to the end of the 
existing file if the specified file already exists.  If you select “Create New 
File/Version” and a file with the specified path and file name already exists, the 
data will be written to a new file with the specified file name plus a five digit 
number appended to the end of the file name as a unique identifier, such as 
“MyDataFile_00001.dat,” “MyDataFile_00002.dat,” etc. 

 

 
                                         Figure 2-11. Creating new datafile.
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2.4 Graphing Data Files 
The graph view is the default for viewing data files.  Any data file with one or more data records 
may be opened in a graph view.  The appearance of graph views may be manipulated extensively 
to aid data analysis. 

• Open a data file to graph by clicking “Open Data File”  or by selecting “File > 
Open > Datafile.”  Or on the control center click “View” to open the current data file. 

2.4.1 Data Selection and Plot Axes 
• Change the plot axes by selecting “Graph > Data Selection…” or right-click in an open 

graph window and select “Data Selection…” 
 

 
 

                               Figure 2-12. Graphing parameters interface. 
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• The axes may be assigned any label for which data exists in the data file. 
• Up to four vertical axes may be displayed on separate plots in the same graph window, 

but all plots in the graph window must share the same horizontal (x) axis. 
• When auto-scaling is selected for all axes, the plot axes will be rescaled each time new 

data is written to the data file so that all data is displayed.  This helps optimize data 
viewing as data is being collected. 

• Quickly auto-scale the axes by right-clicking in the graph window and selecting “Auto 
Scale All Plots.” 

• Use the “>>” button to add custom axis labels and to change the axis scaling multiplier 
by factors of 10. 

• Use the “Filter…” button to plot only records with data that falls within a specified 
range.  For example, specify a range for moment standard error to hide data with a large 
standard error (i.e. noisy data.) 

• The “OK” button applies the changes to the graph window and closes the Data Selection 
dialog.  The “Apply” button applies the changes to the graph window without closing 
the dialog.  The “Cancel” button closes the Data Selection dialog without making any 
changes to the graph window. 

2.4.2 Plot Appearances 
• Change the appearance of each plot by 

selecting “Graph > Appearance > Plot 1” 
(or “… Plot 2,” etc.) or right-click the plot 
you want to change and select 
“Appearance.” 

• Turn horizontal and vertical grid lines on 
and off with this dialog. 

• Choose between markers on each data 
record, lines between each data record, or 
both markers and lines.  The lines shown 
can be limited to only those in the positive 
or negative x-quadrant direction using the 
“>>” button. 

• Check “Apply to All Plots” to apply the 
appearance settings to all plots in the graph 
window. 

 

  Figure 2-13. Plot appearance interface. 

2.4.3 Templates and Graph Files 
Groups of graph view settings may be saved in template files (.tpl) and applied to other data files 
so the graph view of each data file will look similar.  The settings saved in template files include 
all settings in the Data Selection and Plot Appearance dialogs.  This feature helps view many 
different data files in the same graphic format. 
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A graph file (.gph) is a template file that MultiVu automatically applies to the data file (.dat) with 
the same name whenever the data file is opened in graph view.   You may save template files as 
graph files (.gph), but it is not necessary to do so.  MultiVu automatically saves a graph file for 
each data file whenever all graph views are closed so that the graph view of the data file will look 
the same next time it is opened. 

• To save a template file, format the graph view as desired, then: 
○ Select “File > Save Template” 

OR 
○ Select “Graph > Save Template” 

OR 
○ Right-click the graph view window and select “Save Template” 

 

Then specify the path and file name for the template file.  (Specify “Graph Files (.gph)” in the 
“Save as type:” box to save the template as a graph file.  Be sure the file name you specify 
matches the data file you want the graph applied to in this case.) 

 
• To apply a template to a data file, select “Graph > Apply Template…” (or right-click the 

graph view and select “Apply Template…”)  Then locate the template or graph file you 
want to use. 

• “Graph > Restore Graph” applies the settings from the graph file to the graph window.  
This will undo any settings changed since last time the graph file was saved. 

• “Graph > Default Graph” sets the axes to Moment and Time Stamp, with auto-scaling 
on both axes. 

2.4.4 Exporting Data Files 
• Many spreadsheet programs can read the standard .dat files SQUID VSM MultiVu 

generates.  They have a comma-delimited format.  But the files contain additional 
header information and may contain diagnostic data that complicates your data analysis 
or communication with collaborators.  To export data files, or subsets of the data in a 
data file, to an alternate file format use “File > Export…”  This feature generates data 
files from the data you specify in several formats that most graphing and spreadsheet 
programs understand. 
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                                                       Figure 2-14. Exporting data. 

• Make sure “Data File” specifies the file you want to export. 
• Designate the path and file name of the new file to write under “Export File.” 
• Under “Destination File Format,” choose which character will separate data items in the 

new file:  tab, comma, or space. 
• Choose whether you want column headers (column labels), full headers, or no headers. 

○ With full headers, the file format must be comma delimited.  All the header 
information at the beginning of the data file will be written to the new file, 
including sample properties, software revision, and other information used by 
MultiVu.  This header information will appear at the beginning of the exported data 
file and may not be easily imported by other programs.  This option is used to keep 
the existing file format but export a subset of the data. 

• Click “Select Data” to specify which data items to export. 
○ Available data items are listed on multiple tabs. 
○ Check the box next to data items to write them to the export file. 
○ Specify the order of the data columns in the export file by entering numbers in the 

“Col Order” boxes. 
○ To exclude data that falls outside a certain range, check the “Select Range” box and 

specify the range of data to keep. 
• Click “Export” to write the selected data to the new file.  You will see a confirmation 

dialog when the operation is complete. 
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C H A P T E R  3  

Hardware 

3.1 Overview 
In this chapter we describe the SQUID VSM hardware. The goal is to provide enough details to 
help understand how the system is working. In section 3.2 we give a general introduction on the 
system architecture and detail the power distribution, the module bay tower and the dewar setup. In 
the following sections we provide insight into the heart of the instrument: the temperature control 
(section 3.3) allowing to vary the temperature between 1.8 and 400 Kelvin, the magnetic field 
control (section 3.4) generating fields from -7 to 7 Tesla, the motion control (section 3.5) oscillating 
the sample in field, the SQUID detection system (section 3.6) sensing the induced signal collected 
by the pick-up coils and finally the facilities controlling the chamber atmosphere (section 3.7) and 
the cryogen level (section 3.8). Additional hardware such as the sample rod is described in section 
3.9. 

3.2 System Setup 
The SQUID VSM hardware is primarily contained in a two-part metal cabinet.  The upper half of 
the cabinet contains a computer running the MultiVu software and the instrument’s modular 
electronics.  The lower half of the cabinet contains a cryostat:  liquid helium and liquid nitrogen 
tanks and a cryogenic insert that hangs into the helium tank.  The VSM head, or motor, is mounted 
on top of the cryogenic insert.  The lower end of the insert contains the shielded SQUID, 
superconducting magnet, and associated hardware.  The cryostat is mounted on vibration isolation 
springs and magnetically shielded to confine magnetic fields greater than 5 Gauss to the interior of 
the cabinet. The lower half of the cabinet also contains storage for sample rods. 
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                                                   Figure 3-1. General System Setup 

The entire cabinet is mounted on casters to simplify relocation, and has leveling mounts in the front 
to stabilize the instrument in its final destination.  A number of cosmetic panels hide a large amount 
of the equipment, but may be removed to service the equipment or to fit the instrument through a 
standard 91 cm doorway. 

3.2.1 System Power Distribution 
All system electronics are powered from a single power cord, and may be turned off with a single 
switch, except on EverCool-equipped instruments.  (In EverCool-equipped instruments, a 
compressor is required which is powered by a separate grounded 3-phase power cord.)  The 
instrument is rated for single phase 200-230 VAC 50/60 Hz, and will draw 10A.  The power 
distribution unit on the cabinet has two grounded outlets for connecting auxiliary hardware (the 
computer monitor and the pump cabinet) and there are dedicated outlets inside the cabinet for 
distributing power to the equipment.  It is not recommended to use any of these outlets to power 
user equipment. The power distribution diagram can be found in Appendix D.3. 
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CAUTION: The instrument must be plugged into a simple phase IEC 60309 outlet (16A/250 V) 
fused at 16A. (See Appendix D.2.2 for more details).  

Always power the system down before unplugging the power cord. 

On the system side, the power cord is secured to the power distribution unit by a clamp. Do not 
tamper with this setup unless specifically instructed by qualified Quantum Design representatives. 
Risk for irreversible system damage and electrical shock hazard. 

The main power switch has a resettable breaker rated at 10A. 

 

 
Figure 3-2. Power Distribution Unit 

In addition to the main SQUID VSM cabinet, a pump cabinet houses a vacuum pump required for 
instrument operation.  A printer for the computer sits on top of this cabinet.  The power for this 
cabinet is provided by the main cabinet to prevent ground loops.  A metal hose and a USB cable 
also connect this cabinet to the cryogenic insert in the main cabinet. 

The instrument operation is most easily understood by recognizing several different subsystems that 
operate nearly autonomously to generate the desired instrument behavior.  Many of these 
subsystems have components housed in different locations, such as in the pump cabinet, in the 
modular electronics bays, and in the cryogenic insert.  All of the subsystems have hardware and 
software components, and their operation is coordinated by the MultiVu software on the computer.   

These subsystems are: 
• Temperature control system (section 3.3) 
• Magnetic field control system (section 3.4) 
• Motion control system (section 3.5) 

Ethernet 
Network 
(optional) 

Power Out To 
Pump Console 

Power Out 
To Monitor 

Main Power 
Switch 
(10A breaker) 

Main Power Entry 
Cable Connection 
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• SQUID detection system (section 3.6) 
• Chamber atmosphere control system (section 3.7) 
• Cryogen monitoring system (section 3.8) 

3.2.2 Modular Electronics 
The electronic components of the MPMS SQUID VSM are housed in modular enclosures that are 
easily added to the system or replaced in case of upgrade or repair.  (One exception is the gas 
handling controller that is tightly integrated on the top of the cryogenic insert.)  These modular 
electronics communicate with one another and with the system computer using a proprietary, 
industrial-grade network based on the Controller Area Network (CAN) protocol. 

 

The basic SQUID VSM electronics comprises: 
1. a gas handling controller (integrated on the cryogenic insert, model EM-QD) 
2. a magnet controller, model EM-QB (in the cabinet space above the computer) 
3. a SQUID control module, model CM-F 
4. a motor control module, model CM-A 
5. a temperature control module, model CM-G 

The SQUID control module, motor control module, and temperature control module are housed in 
module bays that provide power and CAN bus interfaces in a standardized format.  Additional 
controllers supplied with upgrade options may also be housed in these bays. 

 

 

W A R N I N G !  
Always power module bay tower down before installing/removing modules. 

Installing/Replacing Modules 
The module bays are divided into two categories based on the heat that each must dissipate.  The 
left-most bays are reserved for high-power modules, such as the motor control module and 
temperature control module.  These modules will not fit in the other bays—do not force them or 
equipment damage may result.  The center and right-most bays are for low-power modules, such as 
the SQUID control module.  Low power modules may be placed in any bay.  The excess cooling 
provided in high power bays will not harm them.  You may distinguish low power modules from 
high power modules by the number of banana jacks on the rear panel:  low power modules have 
two jacks, high power modules have one jack. 
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    Figure 3-3. Module bay tower. 
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Figure 3-4. Module Rear Panels 

The panel below the module bays provides access to a modular power supply.  In addition, this 
panel has a connector for communication with the computer, a breakout connector for the auxiliary 
magnet signals (allowing access to the magnet’s modulation coil by another device) and four 
connectors for connecting external CAN-based electronic controllers.  The latter connectors provide 
+/- 24VDC fused power to external modules.  The fuses are behind this panel and should only be 
replaced with equivalent 5A, 20 mm, delay fuses under the direction of a qualified Quantum Design 
service representative.  It is possible for the fuse on a +24V line to open without affecting the fuse 
on a –24V line.  In this case the electronics attached to these QD-CAN connectors may continue to 
operate with limited or unusual functionality.  However, both fuses should always be replaced at the 
same time. 

 

The model EM-QA module controller also utilizes two 6A, 20 mm delay fuses at the power entry.  
These should only be replaced with equivalent fuses on the direction of a Quantum Design service 
representative, and should always both be replaced at the same time. 

3.2.3 Cryogenic Equipment 
 

 W A R N I N G !  
Cyrogens such as liquid helium and liquid nitrogen pose the following 
dangers: (1) They can cause serious burns due to extreme cold. (2) 
They may expand explosively in closed containers if warmed above 
their boiling point. (3) Their vapors may displace the breathable air in 
closed room. (4) Liquid or vapors may backstream out of fill ports 
when removing caps/plugs/transferlines. 

To guard against these dangers, wear protective clothing such as 
gloves and covered shoes when working with these cryogens. Also 
ensure that the room has good ventilation. Never disable relief valves, 
burst disks, or other safety devices on cryogen vessels and transfer 
equipment. 
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Experienced personnel should perform or supervise cryogen 
transfers. 

 

Liquid helium and liquid nitrogen are required to operate the MPMS SQUID VSM.  Tanks, tubes, 
and hoses for these cryogens are often insulated with an evacuated space around them and fitted 
with pressure relief mechanisms (such as burst disks and re-sealing relief valves) to prevent the 
buildup of dangerous pressures.  For both performance and safety reasons, it is critical that no 
vacuum insulation nor pressure relief mechanism be tampered with, modified, or disabled.  All 
users should also be aware of the burn and asphyxiation hazards posed by liquid cryogens.  Please 
read section 1.5 for an overview of these hazards. 

The purpose of the liquid helium is threefold.  Liquid helium cools the superconducting solenoid 
(magnet) that provides the magnetic field in the instrument, and associated components of the 
magnet system such as two superconducting electrical leads and the quick switch.  The use of a 
superconducting magnet system is the only practical way to generate magnetic field strengths found 
in the MPMS SQUID VSM.  Liquid helium also cools the Superconducting Quantum Interference 
Device (SQUID) that is responsible for the instrument’s extreme sensitivity to magnetic moments, 
as well as the SQUID’s superconducting magnetic shield and the superconducting detection coils 
inductively coupled to the SQUID. By means of a vacuum pump, cold helium gas is drawn through 
the space surrounding the sample chamber to cool the sample down to 1.8K. 

The liquid nitrogen in the instrument serves to minimize helium boil-off in several ways.  First, the 
outside of the liquid helium tank is shielded from radiated heat by the liquid nitrogen tank.  Second, 
the upper section of the cryogenic insert, which hangs into the helium tank, is connected to the 
liquid nitrogen tank to intercept conducted heat. Third, this connection is linked to a radiation shield 
inside the cryogenic insert. The radiation shield intercepts heat from the sample chamber and 
heaters which would otherwise radiate to the liquid helium from within. 
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            Figure 3-5. SQUID VSM Dewar
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With the standard instrument cryostat, the hold time for the nitrogen tank when full, under typical 
operating conditions, is approximately 12 days.  The hold time for the helium tank, when full, is 
slightly longer if there is liquid nitrogen in the nitrogen tank.  When the liquid nitrogen tank is 
empty the instrument will no longer achieve the lowest base temperature specified.  In addition, 
the rate of helium consumption will increase.  When the liquid helium tank is empty, the SQUID 
detection system, magnet system, and temperature control system will all fail to work properly, and 
there is potential for damage to the hardware if operated with an empty helium tank.  It is 
recommended to fill both the nitrogen and helium tanks at least every 10-12 days, or once a week if 
convenient.  See chapter one for instructions to fill the nitrogen and helium tanks. 

Except in EverCool systems, the helium and nitrogen that escapes from the cryogen tanks through 
normal evaporation is routed to hose barbs on the back of the main cabinet through 0.2 psi (1.4 kPa) 
relief valves.  Rubber hose allow to route the exhausts to a visible location on the floor, to allow 
visual notification when the nitrogen tank is full during liquid nitrogen transfer. Liquid will be 
expelled from the hose when the nitrogen tank is full. The helium exhaust may be routed to a 
recovery system. 

The N2 exhaust rubber hose features an inline one-way walve at about 80 cm (30 in) from the 
exhaust hose barb. This valve ensures that no air gets cryopumped into the N2 tank. It is 
recommended to check regularly that the hose section between valve and system is not collapsing 
while doing a HELIUM transfer. If this is the case, please contact QUANTUM DESIGN. There 
might be risk for plugging the N2 exhaust with ice. 

3.3 Temperature Control System 
The MPMS SQUID VSM sample chamber has a number of heaters and thermometers attached to 
the outside.  The MPMS temperature module, model CM-G, monitors the thermometers and other 
data, reports the sample temperature, and automatically controls the power to the heaters to obtain 
the desired sample temperature.  Cooling is achieved by drawing helium from the liquid helium 
tank into the annular space around the sample chamber at a controlled rate with a vacuum pump.  
The gas handling controller operates a valve, in line with a flow sensor, to achieve the necessary 
helium flow rate.  To hold temperatures below the 4.2 K boiling point of liquid helium at one 
atmosphere, a capillary tube with carefully tuned flow rate allows liquid helium into the annular 
cooling region from the helium tank.  The region is evacuated to low pressures while helium is 
continuously supplied.  The evacuation is performed by a rotary-vane pump (except in EverCool 
systems) pumping through a solenoid valve that is used for isolating the region under special 
circumstances, such as power loss.
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              Figure 3.6. SQUID SVSM probe. 

The reported sample temperature comes from a thermometer reading that has been corrected for a 
number of factors, including magnetic field, thermometer location, thermal history, and thermal 
conduction from gas flow past the sensor.  These corrections can only provide an approximation of 
the exact sample temperature.  The most accurate sample temperature data is achieved at steady 
state.  Dynamic corrections, and the associated errors, are smallest when the rate of temperature 
change is small. 

Occasionally, the flow impedance or the tube for drawing helium into the cryogenic insert may 
become plugged with ice or other solid contaminants.  A plugged impedance will result in reduced 
helium flow through the probe insert and cause loss or degradation of temperature control below 
10K. In this situation the flow reading of the ball gauges located on the side of the pump console, 
will generally be below 100 ccm. The only remedy is to warm the entire cryogenic insert to room 
temperature.  This may take over a week to do if no accelerated warming techniques are used.  It is 
recommended that only qualified Quantum Design representatives perform accelerated warming 
techniques on an instrument with this type of plug.  To help avoid this condition, follow the tips 
below to keep contaminants out of the liquid helium tank and cryogenic insert. 

• Use clean liquid helium, and do not pull liquid helium off of the very bottom of the storage 
dewar, where solid contaminants settle. 

• Replace the cap on the helium fill port right away whenever transferring liquid helium into 
the helium tank.  Never leave the tank open to atmosphere. 
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• Check the Teflon disk inside the cap of the helium fill port for dirt and debris before 
replacing it.  Watch for poor sealing of the cap during normal operation and do not let a 
leaking condition persist. 

• Be mindful of changes in the rate of helium evaporation coming out of the helium exhaust 
port on the back of the cabinet, if connected to a meter or monitoring system.  An apparent 
reduction in helium evaporation rate might actually be caused by a leak between the tank 
and exhaust port which should be repaired. 

• Never stress, stretch, kink, disconnect, or loosen the hose between the main cabinet and the 
pump cabinet when the instrument is in operation. 

3.4 Magnetic Field Control System 
The magnetic field in the MPMS SQUID VSM is generated by a superconducting Niobium-
Titanium (NbTi) solenoid mounted on the outside of the cryogenic insert.  The solenoid generates a 
vertical magnetic field.  Current is supplied by the magnet controller via a set of permanent current 
leads.  The leads are composed of different materials depending on what part of the system they are 
located in.  In the cabinet, the magnet leads are large gage copper cable.  In the very top section of 
the helium tank they are brass, to reduce the amount of heat that is conducted through them into the 
liquid nitrogen and helium.  Below the brass section, where the temperature is low enough, the 
leads are composed of high-temperature superconductor (HTS) tape, to eliminate Joule heating.  
Below the HTS tape the leads are NbTi (type II superconductor) where they attach to the solenoid. 

In parallel with the magnet solenoid is a superconducting element called the Quick Switch.  The 
Quick Switch is immersed in liquid helium.  It is driven above its critical temperature with a heater.  
In this normal state the magnet controller may generate a voltage across the superconducting 
solenoid.  The solenoid current—and the magnetic field at its center—changes at a rate determined 
by the applied voltage and the solenoid inductance.  The Quick Switch cools very rapidly and 
becomes superconducting when the heater is turned off.  In this state there is a short across the 
solenoid and no voltage may be developed.  Therefore, the magnetic field is extremely stable. 

The magnetic field reported by the instrument is the current that is being driven through the magnet 
solenoid, multiplied by a geometric calibration factor.  It is possible for the magnetic field lines 
within the instrument to move—a condition called “field relaxation.”  It is also possible for a 
magnetic field to become trapped within the magnet even with no net current through the magnet 
solenoid.  This condition, commonly called “trapped flux,” depends greatly on the magnet charging 
history.  (See chapter 4 for more details.)  A heater integrated into the magnet solenoid may be used 
to drive the wire above its critical temperature and eliminate most trapped magnetic flux.  This 
procedure is called a magnet reset.
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               Figure 3-7. Magnet Control Diagram. 

The magnet solenoid also contains a second, much smaller modulation solenoid for supplying small 
magnetic field offsets (to trim the magnetic field to true zero, low field option) and for generating 
AC magnetic fields (for AC magnetic susceptibility measurements, AC option).  

The Magnet Controller, model EM-QB, coordinates operation of the Quick Switch and the current 
in the magnet solenoid.  The novel design of this digital magnet controller utilizes analog feedback 
to achieve very smooth current ramps.  Except at zero magnetic field, this controller always 
supplies current to the magnet solenoid and must not be disconnected from the magnet.  Doing so 
could damage the magnet.  This is different than the operation of many other superconducting 
magnet systems, which often have detachable or retractable leads. 

 

The model EM-QB magnet controller utilizes two 8A, 20 mm delay fuses at the power entry.  
These should only be replaced with equivalent fuses on the direction of a Quantum Design service 
representative, and should always both be replaced at the same time. Spare fuses can be found in 
your utility kit. 
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3.5 Motion Control System 
The motion control system moves the sample within the detection coils.  The VSM head, or motor, 
is a long-throw linear motor mounted on springs within its casing for vibration isolation.  The VSM 
head receives current from the motor control module, model CM-A.  A DC signal controls the 
sample position, and an AC signal determines the vibration amplitude and frequency.  A precision 
optical encoder in the VSM head reads the position of the motor armature to within 0.01 mm.  This 
position is fed to the motor control module and used in a feedback loop to obtain precise sample 
positioning and vibration.  The armature position may be seen through a window on the front of the 
VSM head. 

The default vibration frequency is 14 Hz and has been selected to optimize sensitivity based on the 
mechanical properties of the instrument, but the vibration frequency is configurable as an advanced 
parameter.  The vibration amplitude may be set below 0.1 mm, but 0.5 mm is the practical lower 
limit to achieve precise measurements.  The maximum vibration amplitude allowed is 8 mm, but in 
practice will depend on the frequency used and the mass of the sample and sample holder.  The 
default amplitude is 2mm.  See the section below on the SQUID detection system for considerations 
when setting the vibration amplitude and frequency. 

• The linear motor in the VSM head uses permanent magnets.  These magnets subject 
samples to approximately 200 Oe stray magnetic fields as they are inserted into the 
instrument.  Please contact Quantum Design if this is unacceptable for your samples. 

 
Figure 3-8. VSM Motor. 
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3.6 SQUID Detection System 

 

CAUTION: SQUID detection is extremely sensitive to the magnetic signal generated by your 
sample, but also to external electromagnetic disturbances, such as for example cell-phones, rf-
furnaces or stray-fields of equipment in close proximity. Environmental noise could affect the 
performances of your system. We advice to isolate your instrument from any known 
electromagnetic noise sources. 

The SQUID detection system is composed of: 
1. A set of superconducting detection coils inductively coupled to a magnetically-shielded, DC 

SQUID 
2. A SQUID head that biases the SQUID, provides feedback control and signal amplification 
3. A CAN-based SQUID control module with a digital signal processor (DSP) which performs 

synchronous AC detection 

 
Figure 3-9. SQUID detection diagram. 

The above diagram illustrates the detection system in simplified fashion.  The detection coils are 
configured as a second order gradiometer to minimize signals from external disturbances.  Both the 
detection coil circuit and the SQUID input circuit have heaters that allow the elimination of 
standing currents in the superconducting loops by raising them above their critical temperature, and 
which are operated automatically by the SQUID control module. 
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In the standard measurement, the instrument positions the sample at the center of the detection coil 
set, where the SQUID signal peaks.  The sample is vibrated at 14 Hz and any measurable magnetic 
moment generates a 28 Hz SQUID signal at the input to the SQUID control module.  A digital lock-
in amplifier in the SQUID control module isolates this second harmonic (as well as the first 
harmonic) for analysis and data reporting. (See chapter 4 for more details on measurement theory). 

• With this type of measurement it is extremely important that the sample be properly 
positioned at the center of the detection coils. 

• If using a different vibration frequency, it is also important to select a frequency that is not 
too close to ½ the power line frequency, nor any harmonic thereof. 

The SQUID ranges are labeled 1, 10, 100, and 1000.  This corresponds roughly to the multiplier 
required to convert the output voltage from the SQUID electronics to the number of flux quanta 
(Φo) measured by the SQUID. Range 1 corresponds to the highest gain setting and is the most 
sensitive range.  Range 1000 has the lowest gain and is the least sensitive range.   When the sample 
produces a signal that is too large, the SQUID must be reset many times during the course of a 
single measurement due to repeated over-ranging as the sample vibrates.  Little or no useful data is 
generated, or it takes much longer than the designated averaging time to generate a single data 
record.  Using the autoranging function (default) minimizes the occurrence of such over-ranging. 

• To decrease the sample signal with auto-ranging turned off and prevent such over-ranging, 
increase the SQUID range if it is not already set to 1000.  Alternatively, reduce the 
vibration amplitude.  The default vibration amplitude is 2 mm.  The signal amplitude will 
decrease by the square of the reduction in vibration amplitude.  (e.g. 1 mm vibration yields 
approximately ¼ of the signal size as 2 mm vibration.) 

• Increase the vibration amplitude to generate a larger SQUID signal if the signal is too 
small to measure when the range is set to 1. 

• The software estimates the maximum moment you may measure with given range and 
vibration amplitude settings.  See the “Advanced” tab of the measurement dialog or 
sequence command pop-up. 

3.7 Chamber Atmosphere Control System 
During measurements, the sample chamber and VSM head are normally held in a medium 
vacuum—approximately 10 torr at room temperature.  (The pressure may drop to 1 torr at the 
instrument’s base temperature.)   Retaining a low pressure of gas in the chamber allows the sample 
and sample chamber walls to reach a uniform temperature.  However, it is important that helium is 
the only gas in the chamber when cooling below room temperature.  Water vapor, nitrogen, oxygen, 
and most other contaminants will condense and then freeze as the temperature is lowered, creating 
additional friction when the sample is vibrating, or even blocking sample motion altogether in 
extreme circumstances.  Additionally, contaminants may impact some sensitive magnetic 
measurements, and may impact the instrument’s temperature control capabilities. 

The standard procedure for inserting samples into the instrument involves purging the sample 
chamber and VSM head to ensure the clean environment described above.  This procedure should 
be performed with the sample chamber at room temperature.  The cap must be on the VSM head or 
the procedure will fail.  The chamber is first evacuated by the system vacuum pump to a few torr, 
then it is filled with about one atmosphere of helium gas.  (The helium vapor in the liquid helium 
tank is used, except in EverCool systems.)  The chamber is evacuated and filled with clean helium 
gas in this manner twice more to flush out all contaminants, and then the chamber is evacuated to 
achieve the final pressure.  Finally, the chamber is sealed.
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When the VSM head is open for removing or inserting samples, clean helium gas is allowed to flow 
through the VSM head to prevent other contaminants from entering the head and chamber.  This is 
called the “flooding” state. 

• Avoid leaving the sample chamber open to atmosphere.  Even though the chamber is 
automatically vented as a precaution to minimize sample chamber contamination, it is best 
practice to keep the cap on the VSM head whenever possible. 

Besides the continuous venting state and the purging then sealing operation, the sample chamber 
may also be immediately sealed, or pumped continuously.  All of these operations are performed 
with a series of solenoid valves on a manifold integrated onto the top of the cryogenic insert.  The 
valves are operated by the CAN-based gas handling controller (Model EM-QD), also integrated 
onto the top of the insert. 

 
Figure 3-10. Gas Handling Diagram. 
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3.8 Cryogen Monitoring System 
The liquid helium level is monitored with a superconducting wire with sufficient electrical current 
flowing so that only the portion of wire submerged in liquid helium is superconducting.  The 
measured wire resistance is then proportional to the length of wire not immersed. 

The helium level meter positioning and approximate calibration are shown below.  The top of the 
meter is near the top of the magnet solenoid, and the bottom of the meter is near the SQUID and the 
inlet for the tube that draws helium into the cryogenic insert for sample cooling.   

• It is not necessary to submerge the magnet solenoid in liquid helium.  The magnet is 
cooled by helium vapor and by conduction through copper elements.  In fact, the presence 
of bubbles in the liquid helium around the detection coils may increase noise in some 
sensitive measurements.  Therefore, it is recommended to fill the tank to the bottom of the 
magnet solenoid, where the helium level reading is full (approximately 70 liters.)  This 
much liquid helium may last 12-14 days under normal operating conditions, and if the 
liquid nitrogen tank is not allowed to run dry. 

• The magnet being vapor-cooled, it is required to ramp the magnetic field to zero before 
starting a helium transfer. Otherwise, the warm gas introduced into the dewar might cause 
the magnet to quench. 

• In case you wish to add additional liquid helium reserve, the software reports the 
approximate volume of liquid helium in the tank up to about 110 liters. 

There is currently no meter in the MPMS SQUID VSM for monitoring the liquid nitrogen level.  
The rate of nitrogen evaporation will be fairly constant.  The liquid nitrogen tank should be filled 
every 10-12 days.  It is recommended to fill the nitrogen and helium tanks at the same time. 

 

 

Figure 3-11. Helium level inside dewar. 
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CAUTION: Carefully read chapter 1 section 1.5 for detailed instructions on filling nitrogen and 
helium. 

3.9 Additional Hardware 

3.9.1 Sample Rods 
The sample rods to which the sample holders attach are composed of 
tapered carbon fiber tubes, with adapters on either end.  They are light, 
strong, and rigid—all important features for application in the SQUID 
VSM.  A flexible plastic coupling at the top end helps accommodate 
slight misalignments between the magnetic latch mechanism and 
sample tube.  The magnetic latch mechanism at the top secures the rod 
to the armature of the VSM head.  A bearing at the bottom end of the 
sample rod provides a smooth surface to minimize friction against the 
walls of the sample chamber.  The bearing also contains internal 
threads where sample holders attach. 

• Store the sample rods in the storage space provided on either 
side of the lower half of the instrument cabinet to keep them 
clean and prevent damage.  You must remove any attached 
sample holder first. 

• Be aware of the strong magnets in the top of the sample rod 
as you move the sample rod around your laboratory.  They 
may be attracted to other equipment or debris. 

• Inspect the magnets at the top of the sample rod from time to 
time and make sure they are clean.  Dirty magnets may 
prevent proper latching of the rod to the motor armature.  The 
magnets may be cleaned with a cotton swab and mild 
detergent (no alcohol).  Magnetized debris may be removed 
with lint-free tissue paper or adhesive-backed tape.  If 
damaged, the magnetic latch may be replaced without 
replacing the entire sample rod.  (See appendix C for ordering 
replacement parts.) 

• Inspect the bearing at the bottom of the sample rod 
periodically, also, to be sure it is clean and not noticeably 
scratched, abraded, or worn.  A dirty bearing should only be 
cleaned with a cloth and a small amount of isopropyl alcohol.  
Solvents such as acetone will damage this bearing. 

• Leave the blue bearing on the rod. Verify periodically that the 
bearing is screwed all the way against the sample rod. 

• When screwing the sample holder onto the sample rod, hold 
the blue bearing instead of the fragile carbon fiber rod to 
avoid damage. (see section 1.3.2) 

Figure 3-12. Sample Rod 
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3.9.2 User Kit 
a. The user kit supplied with the instrument contains several items: rigid brass and quartz sample 

holders for mounting samples onto. 

b. A sample mounting station to aid proper sample mounting as described in section 1.3.1. 

c. A palladium sample reference sample, mounted to a sample holder, which may be used to 
check the instrument’s magnetic moment calibrations with the formula below for the 
susceptibility of palladium at room temperature: 

μ=χmHm 

where μ is the magnetic moment of the sample, χm is the mass susceptibility of palladium at 
298 K (5.25x10-6 emu/Oe-g), H is the magnetic field applied by the instrument, and m is the 
mass of the palladium sample (supplied with the sample.) 

d. A mounted Indium sample, which may be used to check the temperature accuracy of the 
system. The superconducting transition at zero field should be between 3.37K and 3.43K. 
Ensure that you have quenched all residual field out of the magnet when performing the M(T) 
measurement. 

e. Two quartz sample braces for helping to secure samples inside the brass sample holder.  These 
braces are intended to mount thin samples perpendicular to the magnetic field. 

f. A set of powder sample holders, allowing to safely encapsulate powder samples and snap them 
into brass holders. 

g. Spare parts for the sample rods: one flexure which mounts to the top of the sample rod and one 
blue bearing, which mounts to the bottom  of the rod. 
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C H A P T E R  4  

Measurement Theory and Applications 

4.1 Overview 
In this chapter we give detailed insight into the measurement theory and the most common 
applications. Section 4.2 outlines the VSM theory based on a 2ω detection principle and focuses 
on various critical effects which need considerations for using the system at its highest 
performance: sample geometry and sample holder effects, sample insertion and location effects, 
and vibration amplitude and frequency optimization. Section 4.3 provides advice on how to 
perform effective M(H), M(T) and M(t) sequences. Data file analysis tips and tricks are given in 
section 4.4, followed by example experiments (section 4.5) and a description of the most 
common sources of errors (section 4.6). Finally, we provide references for further reading 
(section 4.7). 

4.2 VSM Measurement Theory 
The MPMS SQUID VSM is a versatile and complex instrument.  Optimizing your use of the 
instrument and obtaining the highest quality data sometimes requires deeper knowledge than the 
fundamentals of sample insertion and software operation. The sections below help explain the 
practical use of the instrument in detail, with specific examples of common magnetic 
measurements and numerous important experimental considerations. 

The illustration below is a simplified model of the MPMS SQUID VSM detection hardware.  The 
superconducting detection coils are configured as a second-order gradiometer, with 
counterwound outer loops which make the set of coils non-responsive to uniform magnetic fields 
and linear magnetic field gradients.  The detection coils only generate a current in response to 
local magnetic field disturbances. 
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Figure 4-1. SQUID detection schematic. 

Assuming the sample dimensions are much smaller than the dimensions of the detection coils, the 
current in the detection coils is a function of the sample position.  The approximate shape of this 
function is shown above.  The exact shape varies slightly with the size and shape of the sample.  
The current in the detection coils is inductively coupled to the instrument’s SQUID, which serves 
as an extremely sensitive current-to-voltage converter.  Many details of the SQUID circuit are 
omitted for simplicity here, but it is relevant to note that SQUID feedback nulls the current in the 
detection coils so no current actually flows in them, and the feedback current yields the actual 
SQUID voltage for analysis.  See the “Further Reading” section at the end of the chapter for 
references that explain the details of SQUID operation. The SQUID voltage is amplified and 
digitized by the instrument electronics. 

 

 
Figure 4-2. 2ω detection principle. 
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The SQUID VSM measurement technique vibrates the sample at frequency ω about the very 
center of the detection coils, where the signal peaks as a function of sample position, z.  This 
generates a SQUID signal, V, as a function of time, t: 

 

(1)   V(t) = AB2sin2(ωt) 
 

because V(z) = Az2  for small vibration amplitudes, and z(t) = Bsin(ωt).  Here, A is a scaling 
factor relating to the magnetic moment of the sample.  B is the amplitude of sample vibration.  
Since sin2(ωt) = ½ - ½ cos(2ωt) (by identity) the techniques of a lock-in amplifier may be applied 
to isolate and quantify the signal occurring at frequency 2ω, which should be caused exclusively 
by the sample if the vibration frequency is selected wisely.  Briefly, this is achieved by 
multiplying the measured signal with a phase-corrected reference signal at 2ω and then extracting 
the DC component of the result.  This DC component is proportional to the 2ω component of the 
measured signal. 

This technique quickly and precisely isolates the sample signal from other noise sources, 
including drifting SQUID signal and mechanical noise sources synchronized to the sample 
vibration.  The lock-in amplification of the SQUID signal is performed by digital electronics in 
the SQUID control module. 

4.2.1 Sample Geometry Effects 

4.2.1.1 SCANNING FOR SAMPLE OFFSET 

When scanning the sample to determine the sample offset, the software measures the 2ω signal 
component for various vertical sample positions, as described in the measurement theory section, 
then calculates and displays a fit to this data.  The fit function is derived from a point dipole in a 
uniform magnetic field and is therefore not identical to the shape of the function for the 
palladium reference nor any other real sample, but is very similar and will accurately locate 
small, uniform samples.  It is also not identical to the spatial response curve plotted in the 
measurement theory section above, which is a plot of the DC response of the detection coils.  It is 
similar to the second derivative of the DC spatial response curve. 

 

If the scan data shows clear deviations from the fit function, this may demonstrate the sample’s 
deviation from point-like dipole behavior due to its size shape, or magnetic characteristics.  
Alternatively, it may be an effect of a non-uniform magnetic field.  For example, a non-uniform 
residual magnetic field after the magnet is set to zero field is common.  In either case, you should 
carefully consider whether the calculated sample offset is accurate or not. 

4.2.1.2 DETECTION COIL GEOMETRY 

For reference, the dimensions of the MPMS SQUID VSM detection coils are 17 mm (diameter) 
and 8 mm (height, center to either outer coil). 

The instrument is calibrated with a right circular cylinder of palladium  that is supplied with the 
instrument, with diameter 2.8 millimeters and height 3.8 millimeters.  To the extent that your 
sample varies from this geometry, the instrument readings will be impacted in the following 
ways: 
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4.2.1.3 LENGTH EFFECTS (LONG/SHORT SAMPLES) 

For samples significantly longer than the palladium reference, the material at either end of the 
sample generates more magnetic flux for the outer, counterwound detection coils to pick up.  
This has the effect of flattening the spatial response curve of the detection coils—reducing the 
magnitude of A in equation 1.  The result is that the reported magnetic moment appears smaller 
than the actual magnetic moment.  A very long, uniform sample would not register any signal at 
all as long as both ends are far away.  Recommended sample length is < 5 mm. 

Similarly, for samples significantly shorter than the palladium reference the spatial response 
curve is taller and the reported magnetic moment appears to be too large.  Since the magnitude of 
A in equation 1 is determined empirically with a reference sample, one may counter this effect by 
carefully measuring a reference of known magnetic moment and with geometry similar to that of 
the unknown sample, and then normalizing all magnetic moment measurements for the unknown 
sample to this well-known measurement. 

4.2.1.4 RADIUS EFFECTS (WIDE/NARROW SAMPLES) 
The lines of magnetic flux due to a sample will, on one scale or another, look like those from a 
magnetic dipole.  That is, they emanate from the sample and return to the sample.  Because the 
sample cannot completely fill the detection coils, some of these magnetic flux lines return inside 
the detection coils and are therefore not detected.  This is true for all samples and the magnitude 
of this effect depends on the radius of the sample relative to its length and relative to the radius of 
the detection coils. 

Samples narrower than the calibration reference will usually generate smaller signals than 
expected and samples wider than the calibration reference will usually generate larger signals 
than expected.  In other words, if you reduce the radius of a palladium reference sample by a 
factor of 2, its volume decreases by a factor of 4:  the instrument will report a reading more than 
a factor of 4 smaller even though the material has the exact same volume magnetization.  The 
magnitude of this error is described by the term filling factor. 

This effect can also be largely accounted for by carefully measuring a reference of known 
magnetic moment and with geometry similar to that of the unknown sample, and then 
normalizing all magnetic moment measurements for the unknown sample to this well-known 
measurement. 

4.2.1.5 DEMAGNETIZATION FACTOR 

Samples with a large magnetic susceptibility and certain geometry effectively alter their own 
internal magnetic field.  Accounting for this magnetic field correction can be an important 
consideration for many magnetic measurements.  The demagnetization factor is a geometry-based 
value between zero and one that describes the extent of this field alteration.  This effect is due 
only to the sample geometry and susceptibility.  It is not an instrumental artifact.  The effect is 
especially relevant for wide, thin samples oriented perpendicular to the magnetic field—thin 
films in the extreme case—but should be considered for most samples.  For example, the 
demagnetization factor in a spherical sample is 1/3, which can be significant if the sample has a 
large susceptibility.  It is beyond the scope of this manual to derive or tabulate demagnetization 
factors for different sample geometries, but they may be located fairly easily in many textbooks 
and online references. 
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4.2.2 Sample Holder Considerations 

4.2.2.1 CHARACTERIZING SAMPLE HOLDER CONTRIBUTIONS 

Measure the magnetic signal from your sample holder without a sample mounted to it in order to 
characterize its contribution to your measurements. 

4.2.2.2 IMPURITIES 

Impurities in a sample holder may generate signals in the instrument.  If a sample holder is not 
uniform in composition, but contains localized impurities, each point of impurity generates a 
local disturbance in the magnetic field which the detection coils will detect. 

4.2.2.3 SAMPLE MOUNTING 

The sample must be mounted securely to the sample holder.  The sample holder must be 
connected securely to the sample rod.  If the sample does not oscillate synchronously with the 
VSM head encoder array, then the instrument rejects much of the sample signal as out-of-phase.  
Quantum Design does not supply material for securing the sample to the holder.  There are many 
glues and tapes available, depending on the specific application.  Most have some magnetic 
contamination, especially at very low temperatures, so be sure to measure the glue or tape you 
use to determine the extent of signal it produces. 

4.2.2.4 END EFFECTS 

 In an idealized measurement, the sample holder is a long, uniform material.  In this case, the 
sample holder produces no net signal when it is inside the detection coils, because any magnetic 
field disturbance it produces is produced in the same magnitude at the two counterwound outer 
detection coils and the central coil.  If a sample holder does not pass completely through the 
detection coil set, then it creates more local magnetic field disturbance at the top coil than at the 
bottom coil, and there is a net signal due to the sample holder.  This is commonly referred to as a 
sample holder end effect.  To prevent this end effect from impacting measurements, the sample 
should be mounted at least 50 mm from both ends of the sample holder, and should be the same 
distance from both ends.  Also, any non-uniformities in the sample holder—such as bearings, 
fittings, and adapters—should be duplicated symmetrically about the center of the sample holder. 

4.2.2.5 SUPPLIED SAMPLE HOLDERS 

 The sample holders supplied with the instrument are approximately 130 mm long, allowing the 
sample to be mounted 66 mm from the lower end. The VSM head will operate in the center of its 
position range.  The quartz sample holders are the best to obtain the highest instrument sensitivity 
and accuracy.  The quartz holders are brittle and fragile.  For applications where the highest 
sensitivity and accuracy are not required, the brass sample holders are more robust and easier to 
handle.  
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4.2.3 Sample Insertion Considerations 

4.2.3.1 INSPECTION 

Each time you insert a sample into the instrument, inspect the following items to ensure optimal 
performance: 
• The magnetic lock should be clean. 

• The flex joint just below the magnetic lock must not be cracked or damaged. 

• The coupling of the flex joint to the magnetic lock must be secure. 

• The coupling of the sample holder to the sample rod must be secure. 

• The sample holder must be mated straight for proper radial centering within the detection 
coils. 

• The sample holder and your sample should be clean. 

4.2.3.2 SAMPLE EXPOSURE TO MAGNETIC FIELDS 

As you insert the sample into the instrument, the sample is exposed to a magnetic field of 
approximately 200 Oe inside the VSM head.  A small remanent field is also normal inside the 
sample chamber.  Oscillate mode will yield the lowest remenant magnetic field. 

4.2.4 Sample Location Considerations 

4.2.4.1 AXIAL LOCATION ERROR 

It is very important to properly locate the sample axially when performing VSM measurements in 
the MPMS SQUID VSM.  The graph below shows the error in the reported measurement of a 
palladium reference sample as a function of axial position offset for a 2mm vibration amplitude.  
Use this to help estimate the uncertainty in your magnetic moment readings based on your 
uncertainty in the sample position. 
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Figure 4-3. Sample offset accuracy. 

○ Accuracy of sample offset scan:  When the sample has a moderate to large magnetic 
signal (> 1x10-4 emu) and produces a clean, symmetric signal for analysis, the sample 
position determined by the scan is typically precise to 1x10-5 m (10 μm).  When the sample 
signal is weaker or the scan produces an asymmetric signal, the sample position determined 
by the scan may be precise to 5x10-5 m (50 μm), but in this case you should perform 
repeated scans to verify the reproducibility yourself.  For very weak signals, large sample 
holder effects, and cases with magnetic contamination, the scan may actually produce 
meaningless data. 

○ Accuracy of auto-tracking function:  The auto-tracking algorithm used to adjust the 
sample location based on the type of sample holder in use and the thermal history of the 
sample chamber has been demonstrated to accurately predict the sample location to within 
5x10-5 m (50 μm).  The auto-tracking function may only be accurately applied to the brass 
and quartz sample holders. 

4.2.4.2 ANGULAR DEPENDENCE 

It is also important to mount the sample so that it vibrates on the axis of the sample rod.  If the 
sample vibrates off-axis, you may find that the magnetic moment readings depend on the angular 
orientation of the sample holder and sample rod when inserted, to a degree that is extremely 
difficult to quantify.  This is because the instrument’s geometry diverges slightly from the ideal 
geometry:  detection coils have lead-in wires and bend with non-zero radius, the sample chamber 
may not be perfectly co-axial with the detection coils, etc.  Rotate the sample rod to find the 
minimum moment being reported. 
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4.2.4.3 MAGNETIC IMPURITIES 

Magnetic impurities in the sample holder, glue, or securing agent can generate erroneous signals 
and errors in sample offset scans.  Measure the empty sample holder to verify that it is free of 
magnetic impurities.  Routinely measure your glue or securing agent to verify that it is effectively 
free of magnetic contamination. 

4.2.5 Vibration Amplitude Effects 

4.2.5.1 SCALE THE SIGNAL BY CHANGING THE VIBRATION AMPLITUDE 

The sample signal scales quadratically with the vibration amplitude.  Therefore, changing the 
vibration amplitude is an effective way to scale the signal when it is too large or too small.  
Increase the vibration amplitude if the sample does not generate a large enough signal.  Decrease 
the vibration amplitude if the sample generates too large a signal.  The instrument accounts for 
this signal dependence so the reported moment remains accurate when you change the vibration 
amplitude.  Because the vibration amplitude range of the instrument is effectively one order of 
magnitude (0.5 mm – 8.0 mm), this technique yields two orders of magnitude in the instrument’s 
dynamic range for magnetic measurements. 

4.2.6 Vibration Frequency Effects 

4.2.6.1 DIFFERENCE FROM CONVENTIONAL VSM(S) 

Unlike conventional copper-detection-coil vibrating sample magnetometers, a changing magnetic 
flux is not strictly required to generate a signal in the MPMS SQUID VSM.  The sample 
vibration is used only to create a signal at a known modulation frequency and aid the separation 
of the sample signal from instrumental artifacts, not to generate the signal itself.  The size of the 
signal does not depend on the vibration frequency and higher vibration frequencies will not 
improve the signal-to-noise ratio.  This is due to the use of superconducting detection coils which 
produce a current in response to magnetic flux, rather than to a change in magnetic flux as 
produced by copper coils. 

4.2.6.2 CHANGING THE VIBRATION FREQUENCY 

The default vibration frequency corresponds to a mechanically quiet frequency for the system as 
a whole.  There is little reason to use any different vibration frequency.  In fact, by using a 
different frequency you may inadvertently detect additional noise due to electromagnetic or 
mechanical resonances in the instrument or within your laboratory.  If your laboratory contains a 
source of noise, you may find it useful to change the vibration frequency of the MPMS SQUID 
VSM.  Remember that the main signal of interest occurs at twice the vibration frequency.  
Therefore, it is wise to avoid vibration frequencies that are ½ of the power line frequency in your 
laboratory, and all higher harmonics. The AC power in the laboratory (usually 50 Hz or 60 Hz) is 
by far the most predominant source of erroneous signal for instruments such as the MPMS 
SQUID VSM.  When using a different vibration frequency it is recommended to verify 
measurement accuracy using the supplied palladium reference.  To determine the best frequency 
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to use, you may wish to connect a spectrum analyzer to the BNC output (JF-5) on the front of the 
SQUID control module, model CM-F. Examine the frequency spectrum with no sample installed. 

4.2.7 Averaging Time 
The instrument sensitivity improves as the inverse square root of the averaging time.  In theory, 
2x10-8 emu moment may be resolved with one second averaging time, while 2x10-9 emu moment 
may be resolved with 100 second averaging time.  Accordingly, one would expect 6x10-8 emu 
sensitivity with 0.1 second averaging.  However, averaging time less than about 0.25 seconds is 
not recommended due to limitations of the control computer.  For very long averaging times, 
instrument sensitivity will ultimately be limited by 1/f noise sources.  Environmental noise 
sources may become significant. 

4.3 Sequence Considerations 

4.3.1 Moment Versus Field (M(H)) 
The SQUID VSM is designed to perform efficient M(H) loops.  The most accurate data is 
measured when the instrument stabilizes the field for each measurement, which happens very 
quickly.  It is also possible to collect data continuously while changing the magnetic field.  The 
instrument noise floor will increase to over 10-6 emu if you measure while ramping.  In addition, 
since the magnetic field and measured moment actually change over the course of such a 
measurement, the reported values will be averages, which tends to result in “blurry” or imprecise 
data. 

Another consideration for some M(H) measurements is magnetic field error due to remanent 
magnetic field.  The remanent field depends on the recent history of the magnet and is neither 
known nor reported.  For more about remanent magnetic field, see the section below called 
“Common Sources of Error:  Magnetic Field Error.” 

4.3.2 Moment Versus Temperature (M(T)) 
The SQUID VSM is designed to perform large temperature changes quickly and to quickly 
stabilize the temperature.  It is also designed to maintain user-defined temperature sweep rates 
and to perform efficient M(T) measurements.  A high data density may be achieved by measuring 
while changing the temperature.  It may prove more efficient to sweep the temperature at a 
moderate or slow rate and collect data continuously, rather than stabilize the temperature for 
many measurements.  To verify the accuracy of the reported sample temperature while sweeping 
temperature, occasionally stabilize the temperature and continue measuring.  The reported 
temperature and magnetic moment readings will be averages, which can result in “blurry” or 
imprecise data, depending on the rate of temperature and moment change. 
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4.3.3 Moment Versus Time (M(t)) 
 

The speed of the VSM measurement technique makes it feasible to examine some time-
dependent magnetic effects with the MPMS SQUID VSM.  However, the time required to 
stabilize the magnetic field with the quick switch is on the order of 1 second, and the minimum 
time required to collect one data point (minimum practical averaging time) is about 0.10-0.25 
sec, depending on the computer workload.  Time-dependent effects faster than this cannot be 
resolved with the standard SQUID VSM measurements. 

To view time-dependent effects, collect a continuous stream of data.  You will need to carefully 
select the measurement averaging time based on the time resolution and moment resolution 
required.  To examine a sample’s remanent magnetization as a function of time, set the 
instrument magnetic field to zero using the fastest charging rate.  If the instrument remanent 
magnetic field drifts after stabilizing at “zero” field, you may try to stabilize the magnet with the 
“Utilities > Reset Magnet” command.  See “Common Sources of Error:  Magnetic Field Error” 
below for more about remanent magnetic field. 

4.4 Data File Analysis 

4.4.1 Data Recorded in the Data File 
Each SQUID VSM data record consists of a large number of data items.  In addition to expected 
items such as magnetic moment, moment standard error, temperature, magnetic field, and time 
stamp, each data record contains information such as the averaging time, vibration frequency and 
amplitude, center position, SQUID range, in-phase and quadrature (out-of-phase) signal 
component in volts, minimum and maximum temperature and field during the course of the 
measurement, and hardware status codes.  This large amount of information aids data analysis 
and troubleshooting. 

4.4.2 Handling Large Data Files 
The automation and rapid data collection capabilities of the instrument allow you to generate 
very large amounts of data, which can be difficult to manage in spreadsheet programs.  The 
export utility described in chapter 2 helps you extract portions of the data from a data file.  
Alternatively, you may collect only a fraction of the data or set longer averaging times to reduce 
the number of data points collected. 

4.4.3 Verifying Measurement Precision 
To determine the measurement precision, plot the moment and the moment standard error (“M 
Std. Err.”) against the measurement time, or other independent variable.  Compare the standard 
error to the moment reading to determine the measurement uncertainty as a percentage of the 
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total reading.  Also, compare the quadrature signal (“M. Quad. Signal”) to the reported 
moment—this value must also be small for precise measurements.  The quadrature (out-of-phase) 
signal indicates the quality of the vibration-phase-sensitive detection.  The standard error 
indicates the precision of the in-phase signal component. 

4.5 Example Experiments 
Detailed descriptions of how to perform several common experiements with the MPMS SQUID 
VSM are found in the sections below.  It is assumed you are already familiar with the common 
tasks outlined in chapter 1 such as mounting and inserting samples, and have read all the 
application considerations described above. 

4.5.1 Five Quadrant Hysteresis Loops 
Hysteresis loops are easily performed using the “Moment vs. Field” sequence measurement 
command.  Start by writing the following sequence, using the temperature and field parameters 
best suited for your research: 

Set Temperature… 

Wait For Temperature, Delay 10 secs… 

SQUID VSM Moment vs Field… 

Set Field 0.0 at 500 Oe/sec, oscillate, stable 

End Sequence 

The first line sets the temperature at which you want to perform the hysteresis loop, and the 
second line waits for 10 seconds after that temperature is achieved (for stability) before allowing 
the hysteresis loop to begin.  The end of the sequence returns the field to zero in order to power 
down the magnet power supply and prepare for removing the sample.  While not strictly 
required, it is good practice to keep the magnetic field at zero when no field is necessary in the 
instrument. 

 

For the moment vs. field command, you must choose a large number of measurement parameters: 
• Select and drag the field ramp shape in the “Select Start/End Quadrant” area to define the 

starting field and applied maximum and minum fields.  A five-quadrant hysteresis loop 
would normally begin at H0 = 0 and ramp up to Hmax, then down to Hmin, and back to Hmax 
again as shown.  The illustration shows a 2 Tesla, 5-quadrant hysteresis loop. 

             

                      Figure 4-4. Hysteresis loop setup.
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• In the “Field Control” area, select the magnetic field charging rate (“sweep” rate) and select 
whether to stabilize the field at each measurement field or to continue charging (“sweeping”) 
as measurements are performed.  This decision will depend on your sample and on your 
research demands.  Stabilizing at each field will yield greater measurement precision and 
accuracy, but may require more time.  Each data record will report the average magnetic 
field and average magnetic moment obtained over the course of the measurement, so long 
averaging times and fast sweep rates can have a blurring effect on the hysteresis loop data if 
you do not stabilize the field for each measurement.  You may reduce this systematic 
blurring effect by reducing the measurement averaging time (see below) and by reducing the 
field sweep rate.  Data records that are being collected while a range change occurs are 
discarded, so measuring while sweeping could result in occasional holes in the hysteresis 
loop data, since the magnet charging does not stop to re-acquire the discarded record.  If 
sweep continuously is not selected, the instrument will try to obtain the desired number of 
measurements before charging to the next field by re-acquiring data that was discarded due 
to a range change. 

• In the “Data Acquisition” area, select the data spacing.  The most common spacing for 5-
quadrant hysteresis loops are probably “uniform spacing in field” and “continuous 
measuring.”  With continuous measuring you specify the averaging time and the 
measurements are performed in rapid succession.  This may not be particularly useful if your 
ramp will stabilize at each field—it is intended to be used with the “sweep continuously” 
mode selected.  (A setting on the advanced tab allows you to use “sweep continuously” as a 
prerequisite for “continuous measuring.”)  Since the continuous measuring selection can 
generate large amounts of data, you may also choose to keep only a fraction of the data 
records, and discard the rest.  With uniform spacing in field all records are kept.  With 
uniform spacing you also specify the number of fields between Hmin and Hmax at which to 
initiate measurement, or specify the field increment between measurement initiation.  
Finally, you may specify a number of times to repeat measurements at each field.  (This is 
not meaningful for continuous measuring.) 

• Examine the “Approximate Fields” box and “Estimated” box.  This will show you the 
approximate fields where measurements will be initiated, and the estimated time to perform 
all the measurements.  Make sure these estimates both meet with your expectations for the 
hysteresis loop you wish to perform. 

• If you know that you need to adjust the vibration amplitude or frequency, the SQUID range 
setting, the automatic centering setting, or the magnetic field approach mode, or if you need 
to introduce a wait time prior to collecting each data record, you may control these features 
on the “Advanced” tab of the moment vs. field measurement window.  For most 
applications, the default settings will work best. 

Next, save your sequence.  To perform the hysteresis loop measurement, perform the following 
steps: 
1. Mount your sample to a sample holder and attach it to a sample rod. 

2. Insert your sample into the instrument and place the cap on the instrument. 

3. Specify the data file you want the data recorded to.  (This is part of the sample installation 
wizard.) 

4. Purge and seal the sample chamber.  (This is also part of the sample installation wizard.) 

5. Select and run your sequence. 
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6. On the control center, click the “view” button to plot your data as it is being collected.  
Recall that there might be a wait period while the instrument achieves your desired 
temperature before collecting data.  To see the data in standard M vs. H hysteresis loop 
format: 

a. Right-click the data file window and select “Data Selection.” 
b. For X-axis, select magnetic field, and for Y1-axis, select moment. 
c. For Y-2 axis, select moment standard error, to also display the uncertainty in each data 

record. 
d. Check “auto” for each axis to automatically scale the plots to show all data records. 
e. Click “OK.” 

4.5.2 Zero Field Cooling 
Cooling your sample in truly zero magnetic field, as desired for characterizing some 
superconductors, requires careful consideration when inserting your sample into the instrument.   
Since the magnet solenoid windings tend to trap magnetic flux, it is common for the instrument 
to report zero magnetic field even though there is still a small field in the chamber.  (See the 
section above, “Sample Insertion Considerations” as well as the section below, “Common 
Sources of Error:  Magnetic Field Errors.”)  

To minimize the trapped magnetic flux, use the “oscillate” approach mode when setting the 
magnet to zero field.  The command “Utilities > Reset Magnet” may also be used to eliminate 
trapped magnetic flux by driving the windings above their critical temperature. 

 

A zero field cooling experiment might begin, for example, with the following steps: 

1. Mount and insert a standard paramagnetic reference, such as Dy2O3 

2. Set the instrument temperature so your reference has high susceptibility (20 K for Dy2O3) 

3. Set the magnetic field to 10,000 Oe (linear mode), wait for stable field and temperature, then 
measure sample. 

4. Determine susceptibility of the reference:  moment divided by field (m/H). 

5. Set the field to 50,000 Oe (linear mode), wait for instrument to reach this field. 

6. Set the field to zero in oscillate mode, wait for instrument to reach zero field. 

7. Use “Utilities > Reset Magnet” to minimize trapped flux in the magnet.  Click “Yes” when 
the confirmation window asks you to continue. 

8. Measure the paramagnetic reference and use its susceptibility to calculate the remenant 
magnetic field in the instrument. 

9. Set the instrument field to oppose the remenant magnetic field. 

10. Measure the paramagnetic reference again and calculate the net magnetic field. 

11. Adjust the magnetic field again as necessary and repeat until the desired field is obtained, or 
until you cannot achieve better results. 

12. Mount your sample to a sample holder and attach to a sample rod.  Be sure to measure the 
sample offset carefully.  Unless your sample is permanently magnetized, there will be no 
signal when you scan the sample to determine its location.  You will have to use the “Enter 
Offset manually” option. 
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13. Warm the chamber to 300 K and insert your sample into the instrument, exposing it to 200 
Oe of field in the motor.  Specify its sample offset as closely as possible. 

14. Set the instrument temperature or begin your measurement sequence.  It is usually a good 
practice to measure the sample while you cool it in zero field and record the results to a data 
file to help determine the actual remanent field later. 

4.5.3 Critical Temperature Measurements 
The superconducting critical temperature of many elements are well-known.  In fact, high purity 
indium samples are used in the factory to validate the instrument’s thermometery calibration.  
The following procedure is used to perform this measurement and may serve as a model for 
similar measurement of other samples. 

 
1. When measuring type I superconductors, minimize the remanent magnetic field first as 

described in the “Zero Field Cooling” section above.  There will still be enough remenant 
magnetic field to generate a sizeable signal from a superconducting sample below its critical 
temperature.  A minimal magnetic field is necessary to obtain an accurate measure of critical 
temperature. 

2. Mount your sample to a sample holder and attach to a sample rod.  Be sure to measure the 
sample offset carefully.  Unless your sample is permanently magnetized, there will be no 
signal when you scan the sample to determine its location.  You will have to use the “Enter 
Offset manually” option. 

3. Create a sequence that contains a VSM Moment vs. Temp. command, starting above and 
ending below the expected critical temperature of the sample.  Use a short averaging time, 
such as 0.5 sec., because the superconducting phase transition is usually very apparent.  In 
this measurement, temperature precision is generally more important than moment 
measurement precison.  Using a short averaging time allows you to measure continuously 
while changing the temperature and maintain a high data density with relatively small 
temperature uncertainty. 

4. Run the sequence. 

5. Once you know the critical temperature roughly, you may determine it more accurately by 
running another sequence over a smaller temperature range at a very slow sweep rate, such 
as 0.1 K/min.
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4.6 Common Sources of Error 
The following are the most common sources of measurement error: 

4.6.1 Magnetic Field Errors 
The reported magnetic field is derived from the net current that is known to be passing through 
the magnet solenoid.  A correction is applied for the current that passes through the QuickSwitch 
while charging or discharging the magnet.  However, the actual magnetic field at the sample 
location may be different than the reported magnetic field due to magnetic flux that is trapped 
inside the solenoid.  This trapped flux occurs because electrical currents may indefinitely persist 
within the superconducting wire, which lacks electrical resistance, and generate a remanent 
magnetic field.  This magnetic field error depends on the recent history of the magnet and is 
usually the most problematic when the reported magnetic field is very low, or zero.  Use a known 
paramagnetic reference to determine the remanent field and post-process your data to correct for 
this error if necessary.  Automating the magnet charging with a sequence to create a reproducible 
magnet history helps make the remanent field reproducible for a given measurement series.  The 
remanent field will differ if you use different charging operations to set the same magnetic field.  
You may need to characterize the remanent magnetic field following all magnet charging 
operations in your sequence.  Our experience clearly demonstrates the accuracy this procedure 
will achieve. 

4.6.2 Sample Holder Effects 
As described in the section above, the sample holder and sample securing agent may contribute 
to the measured signal.  Measure each independently to determine the effects they have on 
measurements use centering scans to look for other print source dipole signals on the “blank” 
holder. 

4.6.3 Sample Location Errors 
Improperly-located samples will yield measurement errors.  It is important to determine the 
correct sample offset before beginning measurements.  If the sample temperature will be changed 
during or between measurements, it is important to adjust the sample location during the 
measurement process.  Thermal contraction of the sample rod and sample holder will result in the 
sample location changing.  Using the auto-tracking feature is the best way to automatically adjust 
the sample location.  When utilizing the periodic centering scan option, instead, the sample 
location might not be adjusted for each reading, and noticeable discontinuities may appear in the 
data each time the sample location is adjusted. 
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4.6.4 Loosely Mounted Samples 
When samples are not mounted securely to the sample holder they will not undergo smooth 
sinusoidal motion within the detection coils.  The sample signal will be rejected as out-of-phase, 
or unknown measurement behavior will result, and the sample may potentially fall off of the 
sample holder and become lost.  It is very important to mount samples securely for accurate 
measurements. 

4.6.5 Temperature Errors 
The sweep rate of the temperature will dictate the accuracy of the reported temperature as 
compared to the actual sample temperature. The analytical function should provide very 
reasonable accuracy for sweep rates up to 10 K/minute. As noted in the thermometry section of 
the manual, this instrument tries to always report the sample temperature, not just the 
thermometer reading. However, for very fast sweep rates, the user should validate the accuracy 
by comparison to a known response, like the Curie-Weiss behavior of dysprosium oxide. 

4.6.6 Environmental Sources of Noise 
The SQUID system can be sensitive to environmental sources of noise. The most concern is for 
broadband RF radiation, like that associated with arc welding or RF-induction furnaces. 
Electrical transformers can be a source of noise. There are indications that cell phones can also 
disrupt the SQUID signal. 

Another concern is stray magnetic fields associated with charging of other magnets or the 
operation of items like an elevator. The full shield around the dewar will help mitigate these 
effects. 

A simple technique to determine if the system is experiencing interference with external noise 
sources is to monitor the SQUID voltage as a function of time. Look for discontinuous changes 
in the SQUID voltage. While it is best to isolate and remove the source of noise, the VSM lock-in 
style measurement and other software features may be able to reject the interference. Please 
contact a Quantum Design service representative for more details on these procedures. 
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4.7 Further Reading 
The following books and articles are a guide to general SQUID applications. Please see the 
references therein for more detailed issues. 
• Superconducting quantum interference device instruments and applications, R. L. Fagaly, 

Review of Scientific Instruments 77, 101101 (2006). 

• Demagnetizing Factors of the General Ellipsoid, J. A. Osborn, Phys. Rev. 67, 351 (1945) 

• The SQUID Handbook: Fundamentals and Technology of SQUIDs and 
SQUID Systems, Volume I 
John Clarke, Alex I. Braginski 
ISBN: 3-527-40229-2 
Hardcover 
409 pages 
August 2004 

• The SQUID Handbook: Applications of SQUIDS and SQUID Systems, 
Volume II 
John Clarke (Editor), Alex I. Braginski (Editor) 
ISBN: 3-527-40408-2 
Hardcover 
653 pages 
October 2006 

• SQUID Sensors: Fundamentals, Fabrication and Applications 

Series: NATO Science Series E: , Vol. 329  

Weinstock, H. (Ed.)  

1997, 720 p., Hardcover 

ISBN-10: 0-7923-4350-6 

ISBN-13: 978-0-7923-4350-9 
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A P P E N D I X  A  

Maintenance and Servicing 

A.1 Overview 
In this appendix we provide maintenance tips and instructions for user-serviceable items on your 
MPMS SQUID VSM.  For help servicing the instrument, contact your Quantum Design service 
representative.  A list of service representatives can be found on the Quantum Design web site at 
http://www.qdusa.com, or by calling the Quantum Design world headquarters in the United States at 
1-800-289-6996. 

Also, please refer to the supplied manufacturer’s instructions for the vacuum pump, monitor, and 
printer. 

A.2 Periodic Maintenance Checklist 
To ensure proper instrument operation and long instrument lifetime, check the following items on the 
schedule shown. 

Every six months: 
 

 Inspect magnetic latches on sample rods and clean if necessary. 
 Inspect bearing surfaces on sample rods and clean if necessary (do not use solvents.) 
 Check pump oil level and add oil if necessary 
 Check pump exhaust filter located at rear of pump console and drain if necessary. 

Once a year: 
 

 Clean the sample chamber 
 Check serviceable o-rings for cracks and debris 

Once every two years: 
 

 Drain old pump oil and replace with fresh oil. 
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A.3 Service Procedures 
You may perform the following service procedures on the instrument at the installed site. Do not 
perform other service procedures not described here unless expressly instructed to do so by a Quantum 
Design representative. 

A.3.1 Recovering Lost Samples 
If a sample falls off of the sample holder inside the instrument, recover it using a long rod, such as a 
rifle cleaning rod.  Place double sided tape on the end and insert that into the sample chamber.  It is 
important that the tape does not come off the rod!  If you still cannot retrieve your sample please 
call Quantum Design for assistance. 

If a powdered sample is lost inside the instrument, it is recommended that you clean the sample 
chamber using the procedure below. 

A.3.2 Cleaning the Sample Chamber 
The sample chamber may require occasional cleaning, especially if a lost sample has contaminated the 
chamber.  If you know that magnetized material has contaminated the chamber, it is recommended that 
you remove the VSM head prior to cleaning the sample chamber, to prevent contaminating the VSM 
head (see separate procedure below.)  Only isopropyl alcohol applied to a lint-free cloth may be used 
to clean the sample chamber. Use a rifle cleaning rod or similar device with a protective coating such 
as shrink tubing.   

 
1. Set the chamber temperature to 300K and wait for stable 300K temperature to be achieved. 
 
2. Set the magnetic field to zero and wait for zero field condition to be achieved. 

 
3. Vent the sample chamber continuously (“Instrument > Chamber… > Vent Cont.”) 

 
4. Wrap a lint-free cloth on the tip of a long rod such that the cloth is captured and may not be 

released inside the chamber.  A rifle cleaning rod is ideal.  Soak the lint-free cloth with 
isopropyl alcohol. 

 
5. Insert the cloth into the sample chamber and slowly slide it all the way down.  Do not force the 

cloth into the chamber if you feel much resistance—the cloth must not become lodged or stuck 
in the sample chamber! 

 
6. Use a twisting motion to get the cloth to clean the sides of the chamber.  Slowly remove the 

rod and replace the cloth with a clean one.  Repeat until the cloth comes out clean.   
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A.3.3 Pump Oil, Changing and Filling 
Only use the procedure outlined here if your MPMS SQUID VSM is not outfitted with the EverCool 
recondensing dewar option.  Instruments with the EverCool option do not have oil-based pumps and 
require different pump servicing.  See the EverCool user’s manual for service procedures on EverCool 
equipped instruments.  The procedure below ensures that the chamber and annulus are not in a vacuum 
when opening the pump to atmosphere.  This prevents air from streaming in and contaminating these 
spaces while servicing the pump. 

 
1. Set the instrument temperature to 300 K and wait for it to stabilize at that temperature. 
 
2. Vent the sample chamber (“Instrument > Chamber… > Vent/Seal”) 
 
3. Shutdown the instrument (“Instrument > Shutdown… > OK”) 
 
4. Select "Utilities > Log Data…" and switch to the "Diagnostic Items" tab  
 
5. If not already checked, check the box next to "Annulus Pres (Torr)" and monitor its value  
 
6. Wait for the annulus pressure to reach 750-760 Torr. 
 
7. Move items off of the pump cabinet, including the printer. Loosen the screws on the side of the 

console. The front cover and sheet-metal enclose are mounted together. To remove this 
assembly, lift the enclosure at the rear and carefully slide it towards the front before lifting it 
vertically. Place it into a safe spot to prevent damage. 

 
8. Shut down the pump with the power switch on the pump. 
 
9. Drain the oil from the exhaust filter into a cup or drain pan.  The exhaust filter may be drained 

by turning the nipple on the bottom of the filter clockwise with your fingers.  (Do not turn the 
entire clear filter cup unless it is necessary to replace the filter element.  The cup has a 
removable seal that is best left untouched if possible.)  

 
Note:  The exhaust filter may be drained at any time as necessary, but should be checked whenever 

servicing the pump.  It is not necessary to disconnect the pump to drain the exhaust filter. 
 

10. If you are changing the oil, drain the oil from the pump into a cup or drain pan.  The pump may 
be drained by turning the oil plug at the base of the pump counter-clockwise (just below the oil 
level view port.)  If you only need to refill the oil because the oil level is low, skip to step 12. 

 
11. Replace the drain plug and fill the pump with oil through the fill port on top of the pump.  Fill 

only to the marking on the top of the oil level view port.  Use only the oil supplied with the 
instrument.  See Appendix C for re-ordering information. 

 
12. Replace the plug in the fill port and turn the pump back on.  Replace the cover on the pump 

cabinet. 
 

13. Wait two minutes with the pump running before operating the instrument at all.  This allows 
the pump to pump air out of itself and the pumping line. 

 
14. Purge and seal the sample chamber (“Instrument > Chamber > Purge/Seal”). 
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A.3.4 Cosmetic Panels, Removing and Installing 
The cosmetic panels on the instrument may need to be removed in the following circumstances: 

• To move the instrument through a doorway 
• To access the magnet controller, gas handling controller, cryogen tanks (dewar), magnetic 

shielding, vibration isolation, cables, power distribution equipment, cryogenic insert, and 
other associated equipment for service 

The panel in front of the magnet controller may be removed by opening the left cabinet door and 
pulling the panel straight forward.  The panel snaps onto the cabinet in 3 locations.  A similar panel on 
the right side of the cabinet attaches the same way, but rarely needs to be removed. 

The other seven cosmetic panels are plastic and need to be removed and installed in sequence to gain 
access to the hardware in the lower half of the cabinet: 

 
                                                           Figure A-1. Main cabinet cosmetic panels. 

To remove all panels follow the sequence below: 

1. BOTTOM FRONT PANEL 



Appendix A  Section A.3 
Maintenance and Servicing   Service Procedures 
 
 

A-5 MPMS SQUID VSM User’s Manual, 1500-100, Rev. C0 Quantum Design 
 January 2009 

Pull bottom edge of panel away from cabinet (there are snaps on either side), swing bottom edge 
outward, then lift entire panel up, out of lip in top panels. 

To move the cabinet through a doorway, this is the only panel that needs to be removed.  To 
access the equipment above the dewar, continue removing the top panels: 

2. TOP FRONT PANEL 

Open both doors and swing open (upward) the hinged arms above each door to remove the locking 
pins that secure this panel.  Then lift the panel upward, over the VSM head (motor) and away from 
the cabinet.  (Notice how the bottom of this panel sits in notches on the top left and right panels 
(#6)). 

3. TOP CENTER PANEL 

Lift directly upward (tabs on either side locate this panel in the top left and right panels (#6)). 

4. MAGNET CONTROLLER COVER 

Open left door and carefully pull the panel towards you (it snaps to the cabinet in three locations). 

This provides access to the magnet controller and the computer. 

5. MODULE BAY TOWER COVER 

Open right door and carefully pull the panel towards you (it snaps to the cabinet in three 
locations). 

6. TOP LEFT AND RIGHT PANELS 

Remove covers #5 and #6 first, open doors, move cabling out of the way, and lift panels straight 
up (they snap to the sheet metal cabinet in three locations). 

 This provides access to most of the serviceable equipment.  Should you require further access, the 
remaining panels are attached to the cryogenic insert (probe): 

7. PROBE COVER 

 Carefully spread the two front-facing edges of the cover and lift straight upward. 

8. BUTTON BEZEL 

 This panel rarely needs to be removed.  It has a sheet metal frame that is secured to the top of the 
cryogenic insert with four screws.  You may remove the screws and carefully slide the panel 
forward over the helium fill tube.  You will need to carefully disconnect the wiring to the buttons 
and the magnet current leads. 

 When reinstalling the panels, reverse the order of operations. 

A.3.5 VSM Head, Removing and Reinstalling 
It is sometimes necessary or desirable to remove the VSM head (motor) from the system.  For 
example, to clean magnetized contamination out of the sample chamber, you may need to remove the 
VSM head to avoid contaminating it with the magnetized debris.  Follow the steps below to remove 
and re-install the VSM head. 

 
1. Remove any sample and sample rod from the chamber with “Sample > Install/Remove…”  

Select the “Open Chamber” button and wait for the system if necessary.  Then remove the 
sample rod. 
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2. Select the “Shutdown” button. This disables the VSM head. 
 
3. Remove the following plastic panels:  top front panel, top center panel, probe cover.  See steps 

2, 3, and 5 in the section “Cosmetic Panels, Removing and Installing.”  You may skip steps 1, 4, 
and 6 in that section. 

 
4. Disconnect the round cable connector on the back of the VSM head by pulling straight out. 
 
5. Make sure to have the VSM head stand open and close by.  This stand is part of the supplied 

instrument packaging, and is covered by a wooden box with metal clasps and metal handles on 
two sides. 

 
6. Turn the locking nut under the VSM head counter clockwise while holding the VSM head.  The 

head is heavy and you will need to stabilize it. 
 
7. Lift the VSM head straight up and place in the stand.  Never lay the VSM head on its side—

this can damage delicate suspension springs in the head. 

To replace the VSM head.: 
 

1. Position the VSM head over the sample manifold block on top of the cryostat and carefully set it 
in the center.  Rotate until the armature position window faces the front of the instrument. 

 
2. While holding the VSM head, turn the lock nut clockwise until tight. 
 
3. Reconnect the cable by plugging it straight in. 
 
4. Select the “Back” button on the Install/Remove Sample Wizard. 
 
5. Select the “Open Chamber” button again.  This restarts the VSM head. 
 
6. Replace the plastic panels in the reverse order you removed them. 

A.3.6 Moving the Instrument 
The main instrument cabinet has four casters (pivoting wheels) and may be easily rolled from one 
location to another.  However, the weight of the cabinet normally does not rest on the front casters, but 
instead on the rear casters and on leveling feet mounted just in front of the front casters.  This prevents 
accidental instrument movement. 

To move the instrument first remove bottom front panel, as described in the section above.  Then lift 
the front corners of the cabinet just enough to remove the weight from the leveling feet and screw the 
leveling feet up, off of the ground with your fingers.  Use a piece of scrap wood or metal pipe as a 
lever to perform this lifting operation.  You will need to lift near the front corners, where the cabinet 
frame is located, rather than near the center, where the vibration isolation and cryogen tank (dewar) is 
located.  Once the leveling feet are screwed up and out of the way, allow the cabinet to rest on all four 
casters and roll it to its new destination.  With the bottom front panel removed it should fit through a 
standard doorway. 

Take care not to stretch or stress the hose and cables running between the main cabinet and the pump 
cabinet when moving the instrument.  You should have someone else help you by rolling the pump 
cabinet along side the main cabinet. 

Make sure that the instrument is properly leveled again at its new destination. 
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A.3.7 Air Filters, Cleaning or Changing 
The air filter on the front, at the bottom of the module tower filters the air cooling the module bay 
power supply.  It may be removed by removing the four screws holding the frame in place in front of 
the fan.  Clean the filter with mild soap and water to remove dust and debris, and air dry. 

Do not run the system for more than two days without the air filters in place. 

A.3.8 O-rings, Cleaning or Changing 
The various O-rings in the system may need to cleaned and re-greased occasionally.  Use only 
isopropyl alcohol applied to a lint-free cloth to clean O-rings.  After removing any O-ring, inspect it 
for cracks or other damage and clean the O-ring groove and mating surfaces with a lint-free cloth and 
isopropyl alcohol. Use a small amount of silicone vacuum grease to lubricate and lightly coat the O-
ring completely.  The O-ring should just look wet, but no grease itself should be visible or discerned as 
a lump or layer. Reinstall the O-ring only if it is not cracked or damaged.  The utility kit supplied with 
your system contains spares of the most commonly replaced O-rings. Contact your Quantum Design 
service representative to replace cracked or damaged O-rings. 

A.3.9 Replacing Fuses 
The system has several user accessible fuses. In case you encounter situations where a fuse blows or a 
breaker jumps, contact your Quantum Design service representative to allow investigating the reason 
and provide advice. 

Laboratory power outlet: 

According to Quantum Design instructions and for safety reasons, the laboratory power outlet has to be 
equipped with 16A breaker. 

Power Distribution Unit: 

The main power entry located on the power distribution unit at the rear of the system has a 10A 
resettable breaker. 

 

 

 

The Module Bay Tower (model EM-QA) utilizes two 6A, 20 mm delay fuses at the power entry.  
These should only be replaced with equivalent fuses and should always both be replaced at the 
same time. Spare fuses can be found in your utility kit. 

The Magnet Controller (model EM-QB) utilizes two 8A, 20 mm delay fuses at the power entry.  
These should only be replaced with equivalent fuses and should always both be replaced at the 
same time. Spare fuses can be found in your utility kit. 

To access the magnet controller you will need top remove the magnet controller cover, as indicates 
in section A.3.4. 
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A.3.10 Unplugging Nitrogen Exhaust 
There are cases when the nitrogen exhaust mechanism of the SQUID VSM fails due to plugging, 
presumably by air leaking into the dewar.  If the rear, external exhaust fails to operate properly, this 
situation must be remedied before a transfer of more liquid nitrogen.  While the front fill and exhaust 
ports for the nitrogen are a safety release, they should not show venting during normal transfers.  If 
there are limited exhaust capabilities, an overpressure in the nitrogen tank can lead to a catastrophic 
failure of the dewar and damage to the probe. 

The primary advice is to verify there are no leaks into the nitrogen dewar.  Check that both front 
exhausts have the proper o-rings in place and are secure.  Kink the rubber tubing coming from the rear 
exhaust and allow a slight pressure to build up such that releasing the kink results in a burst of nitrogen 
gas.  This test would verify the rear pressure relief valve is operational and the exhaust is at least 
somewhat clear.  If during the start of the transfer the rear exhaust does not open within the first 30 
seconds, then stop transferring.   

It is recommended to transfer the nitrogen and helium on separate days.  Since there is no nitrogen 
level meter and the presence of nitrogen is critical for low temperature operation and minimizing 
consumption of helium, the nitrogen should be added once a week.  Do not use a high pressure (~200 
psi, ~14 bar) liquid nitrogen storage dewar, but instead stay with the lower pressure (22 psi, 1.5 bar) 
rated nitrogen containers.  The helium should be added as needed.   

It is well known that for nitrogen jacketed dewars, the transfer of helium will cause cooling of the 
nitrogen tank such that a vacuum is pulled.  Even though there is plenty of nitrogen in the tank, this 
vacuum can lead to accumulation of ice inside the exhaust ports if there is a leak or if the nitrogen 
ports are opened shortly after a helium transfer.  Normally, this situation will return to equilibrium 
within a few hours after the transfer of helium and the nitrogen gas boil-off will exhaust as expected.  
However, there could develop situations where the exhaust ports are frozen open or leak in such a way 
as to generate a large enough ice plug that completely prevents the exhaust port from working.   The 
solution is to clear the ice plug, find the source of leak and fix it. 

Do not confuse the accumulation of ice on the outside of the exhaust lines with a plugging of the 
exhaust.  With high boil-off rates, ice is expected to appear, especially near the top of the dewar, under 
the foam insulation. 

Contact customer service for additional guidance and the procedure for establishing proper flow out 
the rear exhaust. 

A.4 Initial Cooldown Procedure 
The initial cooldown procedure is required after the system ran out of cryogens and warmed up for an 
extended period of time. Typically at that stage the probe (including magnet) and dewar are at room 
temperature. 

Before starting the cooldown procedure you will need 100 liters of liquid helium, 100 liters of liquid 
nitrogen and a helium gas bottle with regulator. Allow about 3-4 hours for cooling the system down 
from room temperature. 

If you have any questions contact your Quantum Design representative for assistance. 
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A.4.1 Preparing the System 
1. All cables are connected to the probe with one exception: Disconnect the SQUID control cable 

(3501-500) from the SQUID module (model CM-F) plug JF-1. 

2. The pump hose is connected to the pump. 

3. Start MultiVu (the initial starting of MultiVu will be longer due to the software trying to tune the 
SQUID which is temporarily disconnected). 

4. Start a log file (e.g., Date_Cooldown.dat). Select all items in each tab. 

5. Start GHMagnaMon: Open the tools folder from the Desktop and start the GHMagnaMon utility 
software. To initialize it click the Init Can button followed by the Readings button. All valve 
icons should be red (closed). 

6. Start the pump and let it warm up for 5 minutes. 

 
                                                                Figure A-2. GHMagnamon utility. 
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A.4.2 Purging the Dewar with Clean Helium 
1. Install the modified fill port adapter with the hose barb on the helium fill port (the adapter is 

provided with the utility kit). 

2. Connect a He gas bottle to the adapter. 

3. Close valve at helium bottle regulator and click on the Dewar valve in GHMagnaMon. Valve icon 
should turn green (open). 

4. The Dewar is now being pumped-out. Pump for 2-3 minutes. 

5. Click again on the Dewar valve. Valve icon should turn red (close). 

6. Open helium bottle valve (0.5 bar max) back fill the dewar until gas exits the relief valve at the top 
plate. 

7. Repeat purging 2 times. 
 

A.4.3 Flushing the Probe with Clean Helium: 
1. Select Flow Control in side bar menu. 

2. Select the “CCM” tag in the side bar. 

3. Click the Isolation valve to start pumping on the annulus. Valve icon should turn green (open). 

4. Open and close the proportional valve by moving the slide bar all the way up and down. 

5. Repeat 3 times and leave valve fully open. 

6. The flow should increase to over 300 cc/min. 

7. Continue flushing for 15 minutes. 

8. Enter a value of 50 for the flow rate and select Set. 

9. Select ON to start flow control. 

10. Keep GHMagnaMon running in the background. 

A.4.4 Filling Liquid Nitrogen and Liquid Helium: 
1. Connect nitrogen hose to LN2 inlet and start filling. 

2. Get helium storage dewar ready with transfer line. 

3. Make sure helium gas bottle is closed. Quickly unscrew adapter from helium inlet port and insert 
transferline. Start filling the dewar with helium. 

4. Connect the helium bottle to the storage dewar. Pressurize the storage dewar to provide approx. 3 
lpm flow. 

5. In MultiVu start the helium fill utility to monitor the helium level. 
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6. Fill LN2 until tank is full (liquid nitrogen will spit out of the rubber exhaust hose. CAUTION: 
liquid nitrogen could crack your lab floor. Ensure proper protection). 

7. Fill LHe to about 60-80%. If the storage dewar runs dry stop immediately. 

A.4.5 Verifying Probe is Working:  
1. Exit GHMagnaMon. 

2. Reconnect the SQUID control cable (3501-500) to the SQUID module (model CM-F) plug JF-1. 

3. In MultiVu tune the SQUID: In Utilities/SQUID open squid control and select Auto Tune. 

4. In MultiVu set the temperature to 298K. 

5. Install the Pd sample and set the field to 1 Tesla. 

6. Locate the sample and verify moment calibration (see section 3.9.2). 

7. Run a sequence down to base temperature. Note: Running for 1.8K right after an initial cooldown 
might take more time than usual. Allow some time for the system to settle. 

8. Install all cosmetic panels. 
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A P P E N D I X  B  

Advanced Software Operations 

B.1 Overview 
In this appendix we describe advanced operations performed with MultiVu. Section B.2 outlines 
the SQUID range settings. The following sections describe specific diagnostic tools. This is 
crucial in case troubleshooting is required. Section B.3 focuses on diagnostic data logging, 
section B.4 on the background event log and section B.5 on specific SQUID diagnostics. Finally 
in section B.6 we describe how to reset the magnet. 

B.2 Squid Ranges and Autoranging 
The SQUID ranges are labeled 1, 10, 100, and 1000.  This corresponds roughly to the multiplier 
required to convert the output voltage from the SQUID electronics to the number of flux quanta 
(Φ0) measured by the SQUID. As the output voltage from the SQUID electronics is in the range 
±5V this means that the maximum SQUID signal one can measure in each of the ranges is 
roughly ± 5Φ0, ± 50Φ0, ± 500Φ0, and ± 5,000Φ0. However, the maximum full-scale reading in 
emu (or A-m2) depends on numerous calibration factors.  You may simply remember that 1 is the 
most sensitive range, and that each successive range reduces the amplification by x10. 

The instrument is calibrated to minimize discontinuities between ranges; however, discontinuities 
cannot be eliminated completely.  It may be possible to notice the instrument range changes as 
small steps or discontinuities in your data.  The SQUID range is one data item that is collected 
with each data record, so it is possible to examine your data and know whether a range change 
correlates with a discontinuity in magnetic moment data. 

The SQUID range selection appears on the “Advanced” tab of the measurement and sequence 
command windows.  The default setting is sticky autorange. 
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B.2.1 Sticky Autorange 
Change the SQUID range only if the signal is < 9% or > 90% 
of the current full scale range.  This setting minimizes the 
amount of time spent changing ranges and minimizes the 
number of possible data discontinuities due to range changes. 

B.2.2 Always Autorange 
Check the signal level during every single measurement and  

      Figure B-1. SQUID ranging. 

adjust the range for maximum signal every time.  Signal may not exceed 90% of full scale.  This 
setting maximizes the signal level, but also creates potential delay determining the best range 
setting for every data point and allows for data irregularities when the signal level is very close to 
the range boundaries. 

B.2.3 Fixed Range 
Keep the SQUID set to the selected range. Note that the system will not collect any data points 
with this setting if the signal exceeds the maximum of the selected range. 

B.3 Logging Diagnostic Data 
The menu command “Utilities > Log Data…” is used to log diagnostic data for the instrument.  
To use the logger, click “Browse” and specify a file name to write to.  You may specify a new 
file name or an existing file name.  Be careful:  If you check the “Overwrite Existing File” box, 
any existing data in the file will be deleted!  Also, specify how often to log data records to the 
file.  Some problems are best diagnosed by very rapid data logging for a short period of time, 
while others are best diagnosed with very long logs with infrequent data records.  A Quantum 
Design representative can usually help you determine the most appropriate logging interval to use 
when troubleshooting. 

When you click “View Data,” the specified data file will be opened in a graph view.  But no data 
will be present in the file until you select data items to log from the other three tabs—“Standard 
Items,”  “Diagnostic Items,” and “Advanced Items”—and until you click “Start” (begins the 
logging) or “Acquire Once” (records all of the checked data items one time only.)  Once logging, 
data will continue to be recorded to the file at the specified rate until you click “Stop.”  You may 
change the data items being logged while the logger is running.  A time stamp always 
accompanies each data record. 
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Figure B-2. Data logging interface. 

B.3.1 Standard Items 
Standard Items include basic information generally available in the MultiVu status bar.  The state 
of the sample chamber, temperature control, field control, and motor are recorded in the data file 
as integers.  The log data window displays the meaning of each of these status codes in real time, 
but this text is not included in the log data files.  (Use “Utilities > Status Calculator…” to 
decipher the status codes.  The “Query” button will decipher the instrument’s current state.) 

 

 
Figure B-3. Selection of data to log. 
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B.3.2 Diagnostic Items 
Diagnostic Items include more detailed information about the data from each individual sensor or 
transducer in the system. 

B.3.3 Advanced Items 
Advanced Items are all configurable data items.  A large amount of raw instrument data is 
available for logging when required.  Configuration of these data items is accomplished with a 
map file which is usually supplied by a Quantum Design representative. 

The menu command “Utilities > Sigma Log Data…” contains very similar capabilities as the log 
data command, except that you may log the statistics (stats) average and standard deviation of 
each data item as well.  This generates data files that are significantly larger and more tedious to 
navigate than the standard log data command.  The average values recorded with this command 
may be a simple average of all new data, or a running average of the last several data items, in 
which case each average may be calculated with some of the same data as the previous data 
record. 

The log data and sigma log data commands have counterpart sequence measurement commands 
which may be executed within a sequence to start and stop data logging, change the log file or 
logging rate, or change the data being logged. 

B.4 Using the Event Log 
The event log is a text file containing diagnostic messages generated by the instrument, with time 
stamps.  The event log is limited to 10 MB in size, and will begin over-writing itself when this 
limit is reached.  It is arranged chronologically. 

You may specify the different level of diagnostic messages that are displayed in the MultiVu 
event log viewer.  Message levels range from informational to fatal errors.  Access the event log 
with the menu command “Utilities > Event Log.”  If you experience a problem with your MPMS 
SQUID VSM, you may be instructed to read the contents of the log to help determine the source 
of the problem. 

Anytime an event occurs (with a level which is enabled in the Event Log viewer), a little dialog 
box with the three most recent events will be displayed. This ensures that you don’t miss 
potentially significant error messages. 

B.5 SQUID Diagnostics 
SQUID VSM MultiVu contains a diagnostic SQUID interface which allows you to change the 
SQUID bias, range, and offset.  In addition, it allows you to quench the SQUID and the SQUID 
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input circuit, eliminating standing currents by heating them above their critical temperature.  You 
may also zero the output, tune the SQUID, and determine the transfer fraction (V/Φ0).  The 
“Output” selection allows you to control what signal is present at the BNC connector (JF-5 and 
JF-7) on the front of the SQUID control module, model CM-F. 

These procedures are rarely necessary under normal instrument operation.  They exist for use by 
service personnel and engineers.  The SQUID diagnostics are accessed with the menu command 
“Utilities > SQUID.” 

B.6 Resetting the Magnet 
 

Because it poses no resistance to the motion of electrons, the superconducting solenoid in the 
MPMS SQUID VSM tends to “trap” magnet flux.  It can be very difficult to drive the magnet to 
truly zero magnetic field.  Even though there is no net electrical current through the solenoid and 
no voltage across it according to the magnet controller, small currents may still circulate within 
the superconducting material. 

Resetting the magnet is one way to help minimize the magnetic field or field gradiants in the 
sample chamber.  The operation is completely automated, but should only be initiated by a user 
who understands the operation.  The software first drives the magnet to zero field and then 
applies heat to the magnet with an integrated heater to drive the superconducting solenoid 
windings above their critical temperature.  After resetting the magnet, some time is required for 
the magnet to cool back down to operating temperature. So you should wait a couple of minutes 
before charging the magnet again. 

Reset the magnet with the menu command “Utilities > Reset Magnet.”  A confirmation window 
will follow. 

Note that resetting the magnet can use a significant amount of helium boil-off. For most purposes 
simply oscillating the field to zero from a field of a few tesla will provide a similar end result 
while requiring significantly less liquid helium. 
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A P P E N D I X  C  

Ordering Replacement Parts 

C.1 Overview 
In this appendix we list the Quantum Design part number for loose or consumable parts you may 
wish to order throughout the lifetime of the MPMS SQUID VSM. Contact your local Quantum 
Design representative to order parts. 

 

Picture Name Part 
Number 

 
quartz sample 
holder 4500-604 

 
brass sample 
holder 4500-608 

 

palladium 
reference 
(mounted) 

4500-612 

 

 
sample rod 4500-600 

 

magnetic 
latch for 
sample rod 

4096-358 

 

sample rod 
flexure 4500-607 
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Sample rod 
bearing 4500-603 

 

sample 
mounting 
station 

4500-620 

 

ultratorr 
fitting (tube 
fitting) for 
helium 
transfers 

YSS-6-
UT-A-8BT 

 

nitrogen fill 
port plug 4504-032 

 pump oil HH-110-
25-012 

 

activated 
alumina for 
oil mist filter 
on rotary 
vane pump 

H026-00-
050 

CONSULT A QUALIFIED QUANTUM DESIGN SERVICE REPRESENTATIVE BEFORE 
REPLACING ANY O-RINGS OR SEALS. 

 

teflon gas cap 
seal used on 
helium inlet 
plug 

4504-002 

 
o-ring for 
nitrogen fill 
ports 

VON2-012 
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o-ring for 
transfer line 
bayonet 

VON2-014 

 

o-ring for top 
of sample 
space 
manifold 

VON2-020 

 o-ring for 
motor cap VON2-022 

CONSULT A QUALIFIED QUANTUM DESIGN SERVICE REPRESENTATIVE BEFORE 
REPLACING ANY FUSES 

 

fuses for 
module tower 
power entry: 
6.3A, 20mm, 
delay 
(external) 

FD6.3-
20MM 

 

fuses for 
magnet 
controller 
power entry: 
8A, 20mm, 
delay 
(external) 

FD8-
20MM 

 

fuses for 
module bay 
QD-CAN 
outlets: 5A, 
20mm, delay 
(external) 

F5-
20MMSB 

 

fuses for 5V 
power output 
in computer: 
3.15A, 
20mm, delay 
(internal)  

FD3.15-
20MM 
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A P P E N D I X  D  

System Specifications and 
Interconnects 

D.1 Overview 
In this appendix we provide information on system specifications, such as power requirements 
and operating conditions (section D.2). We further provide interconnect diagrams for a more 
detailed understanding of the system architecture (section D.3). 

D.2 System Requirements and Operating Conditions 
Quantum Design service representatives will perform the initial installation of the system. These 
are however various requirements which need to be fulfilled prior to the installation. 

D.2.1 Power Ratings 

Voltage:  200-230 VAC, 50/60 Hz, single phase 

Current:  typical operation 6-8 A 

Mains Fusing:  10 A breaker at main power switch 
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D.2.2 Laboratory Power Outlet Setup 
Laboratory power outlet is required to be fused to 16A MAX. 

The Power cord supplied with the system is 2.5m (10 ft) long. The power outlet should be within 
that distance from the planned system location or an extension cord will be required (not supplied 
by Quantum Design). 

Laboratory outlet specifications: 

International industrial type connector 
IEC 60309 6H Female 
16A/250V 
2P+E 
I44 (splash proof) 
Color Code: blue 
Safety approvals: UL/CSA, VDE, IEC 
 
                                                                                           Figure D-1. Laboratory Power Outlet. 

D.2.3 Laboratory Ambient Conditions 
Operating ambient temperature: 10-40 °C (50-104 °F) 
Operating ambient relative humidity: 10-90% (non condensing) 

D.2.4 Cryogenic Requirements 
For the initial cooldown the system requires the following quantities of cryogens: 

Liquid Nitrogen: 100 liters 
Liquid Helium: 100 liters (another 100 liters should be available as a back-up) 
Pressurized Helium gas cylinder with regulator 

Under normal operating conditions the cryogen holdtimes are typically 12 days for helium (100% 
= 70 liters) and nitrogen (100% = 55 liters). See section 1.5 for more details on transferring 
cryogens. 

In case the system warms up, follow the cooldown procedure described in Appendix A.4. 

D.3 System Interconnects 
The various system interconnects are shown below to help understanding the general architecture 
of the system. Most of these interconnects do not need to be serviced by the user at all. 
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Figure D-2. SVSM System Architecture 
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Figure D-3. SVSM System Interconnects 
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Figure D-4. SVSM Power Distribution Diagram 
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Figure D-5. SVSM Cryogen Plumbing Diagram 
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